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	Chapter one:

How to use Multimedia Languages in Education
In.For.Ef (BE)


1. Introduction

Methodology of work with educational multimedia material is not an easy task for the teacher who is used to working according to traditional principles of teaching. However having overcome certain difficulties (most frequently of psychological nature) this style of work may prove to be very satisfying for teachers and their students as well.

In order to achieve an increased educational efficiency a long term strategy must be planned. It will depend if the role of multimedia material is to fulfill in educational process both from methodological and technical point of view which is in fact dependent on the place and manner of teaching. It is advisable to consider the following possibilities: 

· The process of learning and teaching is only based on multimedia material. This assumption calls for an easy access to a computer room.

· Multimedia material must assist the process of teaching (presentation of video sequences, animations, simulations of experiments). In this event only one computer is needed in the classroom (preferably connected to a TV monitor).

· Multimedia must be used to practice the students’ skills and test their knowledge (doing tests, tasks and exercises). Again one computer in the classroom will be sufficient. However the students should have access to a computer room once or twice a week (possibly for individual studies).

· Multimedia material is used for multimedia testing (doing tasks and tests or a class test with tasks and tests sent to students via the network). This assumption calls for a computer in the classroom as well as access to a computer room.

· Multimedia material constitutes an additional source of information. It must be available at school library (either to be used in the library or to be rented for home study).

· Multimedia material must be used by students exclusively at home (the teacher may recommend doing certain exercises and tasks or solving a problem. This assumption requires an easy access of most students to a computer.

Pedagogical research on the efficiency of the educational multimedia material is to answer the following questions:

· What does educational efficacy of multimedia material mean when compared to other didactic?

· Does the structure of the multimedia product influence the efficiency of learning and its individualization?

· Does the work with the multimedia product influence a better understanding of the material and does it shorten the time needed to acquire knowledge?

· To what extend does the multimedia product increase the number of correctly solved problems?

· Does using multimedia material contribute to develop student’s cognitive activity as well as improving their skills?

2. Analysis of multimedia software 


2.1 “The Mechanisms of Chemical Reactions”

We refer to the paper written by H. Gulińska and M. Bartoszewicz, Faculty of Chemistry, Department of Chemical Education, Adam Mickiewicz University, Grunwaldzka 6, 60-780 Poznań, Poland.

www.formatex.org/micte2005/382.pdf
This paper presents a piece of multimedia software “The Mechanisms of Chemical Reactions” which contains animations illustrating subsequent stages of selected organic chemical reactions, videos illustrating the execution of chemical experiments as well as texts, hypertexts, interactive exercises and tasks.

This software was prepared in Macromedia Authorware environment with the use of Flash. Thanks to internal script language, Flash animations can interactively cooperate with their viewers. Videos illustrating the course of chemical experiments when the discussed mechanisms of reactions take place were prepared at the film studio of the Institute of Didactics of Chemistry at Adam Mickiewicz University in Poznań.

The software has an open structure which means that it is possible to include new mechanisms of reactions.

Each module includes

· Texts and hypertexts relating to the topic of the experiment

· Sets of animations explaining the mechanisms of chemical reactions

· Dynamic models of chemical compounds

· Sets of videos presenting the course of the experiment

· Information on laboratory techniques

· Sets of safety regulations for experimental work

· Interactive glossary

· Tasks, exercises and self-check tests

Fig. 1-4 Animations of the mechanisms of chemical reactions.
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Fig. 5-8 Video sequences showing the course of reactions.
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2.2 StarBoard 

An interactive board was used during computer assisted Chemistry classes. This board is a device which combines the elements of a screen for presentations, self-copying board and computer monitor. As the board may be connected to a computer via a cable or via an infra red connection (wireless) it is possible to carry out dynamic work and continuously save the notes on the hard disk.

Electronic pen is the device which the user may write on the board (no ink required – an alternative for the traditional whiteboard). The software of StarBoard makes it possible to stop the presentation at any moment, transfer any of its elements to the environment compatible with its software and to modify it freely.

Using StarBoard and its software will allow presenting the mechanisms of chemical reactions in a dynamic way thus replacing the omnipresent diagrams, drawings and static notations which illustrate the course of reactions by means of the equations of reactions. The user of StarBoard may also print out the materials from the class which might eliminate making detailed notes from classes and direct the students’ attention to the subject of the class. 

Moreover the dynamic manner of teaching allows the teacher to do problem tasks directly on the elements copied from the presented software thus eliminating the need to prepare additional presentations which will shorten the time the teacher must spend preparing for the class.
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Fig. 9-12 The course of a class with the use of interactive board.



2.3 Scenario of computer assisted classes

“The Mechanisms of Chemical reactions” and the StarBoard were used during this class:

· Introduction to esterification reactions (multimedia software in co-operation with the board – texts, films and exercises)

· Instruction to the experiment Production of ethyl acetate (having watched the video sequence showing production of ester, the students carry out the experiment on their own and write down their notes on the interactive board)

· The mechanism of esterification (animation illustrating the stages of reaction including transitional products – the possibilities of the interactive board are used whilst discussing the course of esterification, the students’ activity may be expressed while they write down the equation of reaction)

· Modelling the substrates and products of reaction (animation showing dynamic models of chemical compounds – the students build identical models of sticks and balls and then write down summary formulae and the names of compounds on the board – competition)

· Revision of material with the use of interactive board (blank test)

· Test (interactive multiple choice test)

3. Language learning with multimedia games


3.1 The European project “I speak therefore I write”

The programme “I speak therefore I write” is one of the most relevant electronic contents already produced in the framework of previous projects financed by the European Commission.

From October 2003 till October 2005 teachers and experts in French language teaching from 7 European countries worked in this project in order to help all pupils who face difficulties with the process of learning to read and write in French. 

An innovative approach has been successfully experimented in countries where French is the mother tongue and therefore the day-to-day language of the whole population, as well as in countries where French is taught as a second language.

In order to make language learning more attractive, the partners of the project conceived multimedia games which can be easily adapted for all levels of learning. These games and exercises are interactive and fun. Moreover multimedia games allow pupils to practice on their own, and help them to build self-confidence as they learn to communicate and express themselves.

This multimedia material was realised with Macromedia Flash. The advantage of this educational material is to merge different media (texts, sounds, images, animations) so that pupils receive information by different ways. Pupils’ attention and understanding abilities are therefore increased. 

For example, the pupil can read and hear the instruction of a virtual character who explains the objective of the game and how to achieve it successfully. 
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When the pupil achieves the game with success, the virtual environment gives him a positive or negative answer. The reaction is unexpected and sometimes surprising. For example in the following game, the pupil has to click on the sound “i” in the words which appear on the screen. When the answer is correct, an animation shows the activities of the letter “i” for each day of the week. Appropriate sounds can make the game more attractive.
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[image: image162.wmf][image: image163.wmf]A strip cartoon becomes a multimedia game in which the pupil can read and hear a story, answer to some questions in order to check they have understood the main events. 
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    Through an interactive story, pupils observe and resolve the most common difficulties of the French spelling. 
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4. Simulation software for environmental sensitisation


4.1  “VirtVal, the virtual valley”

In the framework of the European project “eurEAUform@”, teachers and experts from 4 European countries conceived this multimedia material in order to train pupils and students for an effective use of water resources.
“VirtVal” is an interactive application, which shows you a valley in a temperate climate zone. You can keep the natural forest or you can replace it by agriculture or settlements. Everything you change will influence the water quality. You can decide between economic changes (advantages: low costs for new buildings, high agricultural outputs,…) or the most effective use (cleaning of sewage, reducing of pesticides, …) 
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[image: image170.wmf][image: image171.emf][image: image172.emf]
You can check the water quality in different check points:

· before human interference  

· after every changing in the use of the area 

· after every improvement 

How?

“VirtVal” uses bio-indicators which are in all running waters and which indicate even the tiniest change in the water quality: the diatoms.  The diatom is a type of alga which is very small and notably sensitive. The diatoms are almost unknown by teachers, because no microscopes are usually strong enough to show them.

[image: image173.emf]
[image: image174.jpg]



Here is one of the most important advantages of simulation tools for education: the use of interactive and multimedia technology allows realising virtual experiments which are not applicable in the real conditions, for different reasons.

Software: 

http://inforef.be/swi/virtval.htm
Information for users (in French):

http://inforef.be/projets/eureauforma/mode_d_emploi.doc 

	Chapter Two
How to Produce and Manage Images with IT

University of Fine Arts of Brera (IT)


2D Image

As it is largely known, most of the images, photos and drawings which are produced must be represented on a bi-dimensional surface. They are often intended to be “flat”, while in other circumstances different devices, such as the axonometric and perspective projections, try to create the effect of depth, that is of the third dimension.

As to the photographic image, the use of computer allows to work it out in every aspect, both through simple operations of photo retouch and through more complicated actions such as the photomontage of different parts and different photographs. Beside, we can also produce graphic elaborations by using special effect, or by varying the original colours in intensity, saturation or composition.
In this way, thanks to the various devices of recent software, even the most unbridled imagination of an operator is put to a hard test.
In the field of drawing in itself, that is formed by lines and coloured areas, the instruments and effects at our disposal are numerous and effective but they generally produce less conspicuous results, if compared to the photographic image. However, given the difference between drawing and photography, the operator’s creativity is highly stimulated and his/her control on the started operation is strict: we can think about the multitude of compositions we can create by combining lines and regular or non-regular geometrical figures, or by using instruments such as “morphing”, to change one form into another, or effects capable to deform the drawing as we prefer.
In this kind of work, the operator must pay a careful and continual attention because even the slightest indecision in his/her operative thought or an approximation in the carrying out can’t be hidden; on the contrary they are emphasised by the strict rigour which generally governs this kind of “programmed design”.
It is also important to remember that, through given operations, it is not difficult to transform a drawing into something completely different, which we might call “metaphotography”; an image of photography which couldn’t be produced through the use of normal photographic technologies.

In this way, once we have overcome the technical limits of drawing and we have reached the wide possibilities of the pictorial or photographic image, all the operative instruments above described can be used.
If we refer to the traditional way of doing art, we could make a comparison with the painter’s way of working, and his first preparing the drawings and then transforming them into pictures.
How to use Image processing software
 This field started with the photo-retouching software, as the well-known PhotoShop. These softwares permit to elaborate every kind of image or photograph working on the so-called bitmap images.
Every type of contemporary media image passes trough this elaboration process. Here we give an examples of guided use of these tools to produce different kinds of images. 
Photoshop

The aim of this tutorial
 is to make you understand the potential and possibilities offered by the softwares of the so called "photo retouching". This term, commonly used, is a bit too narrow. A software like Photoshop (or similar ones) allows us to go further and surpass the simple "retouching" of a picture or an image. It is like as if you were in front of a white canvas, with all the colours you can imagine (sixteen millions), brushes, pencils, aerograph or, if you prefer, glue, scissors and material to be cut and sticked, up to your final digital papier-collé. In fact Photoshop gives the chance to simulate all the traditional instruments, with the advantages and flexibility offered by the digital technology. 
And don't worry about making mistakes, because you can always go back and cancel what you have just done…therefore no more works to be thrown away because of a drop of colour that fell down in the wrong place, or because your cat chose your work as its bed for the night. 

Let's see more closely what we are talking about.
The most commonly used software is Adobe Photoshop, so I will refer to it for my convenience. In any case there are many other similar ones, with very little differences, like Corel Photo Paint (which you find in CorelDraw), Paint shop Pro, Painter. You are not therefore obliged to use the software by Adobe; but, considering the differences on the screen, those who don't use Photoshop during the tutorial will have to find the equivalent controls.

Once you launch the software, you will find yourself in front of a big void area, where your image will be visualized, and a series of icons, signals and menus on the sides of the screen.
On the left you can find a list of icons that indicate the tools: brushes, airbrush, eraser, instruments of selection or filling...
On the top you find the menus, listed and subdivided according to categories, from the opening, saving and handling of a file to operations about the modifying of an image, like rotations, cutting down ,handling of colour, contrast, to the filters, that up to now we can consider as special effects, and to the various helps.
On the right you can find the signals, divided in groups, which allow you a quick and easy access to controls you can otherwise reach through the menu; the enlarging factor, the colours currently in use, the information about the image etc... Moreover in the signals we can find two other fundamental elements: the history and the layers. The history records all that you do and allows you to go back when you make mistakes or when you want to revise your steps, and exactly to the point you desire: the time machine of Photoshop.

The layers are an essential element of the graphic of the calculator, which exist also in many other software of other kind (vectorial, three-D, Flash and similar ones). The concept which is at the basis is simple but it is very important to understand it because it makes the work quicker and more flexible. Every element of your composition can be positioned on a different layer. It is as if you worked on transparent sheets that are superposed and, seen together, compose the image. The layers are the transparent sheets. Imagine you have a composition with an image on the foreground and a background. By keeping these elements on two separate layers you will be able to modify, enlarge, eliminate, and move an element without influencing the other one. It is as if, once the drawing of the model on your sheet is finished, you suddenly realize that it would be better to move her on the left of your sheet. With Photoshop you don't need to cancel and redraw her, you must simply drag the layer with the model on the left. Not too bad.
	Let's consider a little practice. As we have seen, Photoshop allows carrying out a lot of operations. We start from the most obvious: the coloration of an image. We won't start from the beginning, but from a sketch or from a drawing by pencil or ink. And it's possible also to draw directly on the pc, but a good graphic tablet is necessary, and however joining the advantages of the traditional techniques to those offered by the digital give often the best results. I find the final aspect that the image assumes very interesting, a mixed "taste" of pixel and ink. 

A tablet will suit you however, in fact the greatest disadvantage of the mouse is the loss of the "wrist" (try to draw a dash...), besides the tablets are sensitive to the pressure and they simulate therefore also the enlargement of the line and the increase of its intensity. In a while they will also make your hands dirty of color! But don't worry, even without them excellent results can be reached, also considering that in a lot of operations the "wrist" is not necessary, while on the contrary the head always is! 

You can choose whether to import an image with your scanner or whether to use my "Frogman". The important thing is that if you choose to use your image this must be sketched, not a pictorial one, and black (or grey). You can also import a cartoon from a comic strip in black and white. 

. 



	 

	Let's begin. After having opened the file, make sure that the image is in RGB, that is color - image_mode_rgb color -. Increase the contrast - image_adjust_brightness/contrast - until to get a darker grey, almost black. 





	 

	Now a very important step, the essential command of the comics drawer: we have to make sure that our colors don't influence "the inks": we release the background that contains the inks and we create a new layer. The new layer, that will contain the color, must be set below the inks. We now set the layer with the inks on multiply. To release the background click on it, to create a new level: - layer_new_layer - , to order the sequence of the levels all it takes is dragging them, to set on multiply: - menu - above the palette layers. Always rename your layers (in this case call one of them ink, the other color): it will be easier to find them again, especially when you work with many of them. 

Now while working on the layers under the inks the color will cover the white and will leave the black intact, this thanks to multiply. 





	 

	Start to color the sketch, for now with flat shades, with the brush. Assign a new layer for every part: one for the complexion, one for the suit, one for the cigar and the smoke. To be precise zoom the area in which you work with the navigator, and vary the dimension of the brush used according to the area to fill. 





	 

	Now it's time to give light; you start from the complexion, selecting it with the magic wand, in this way you won't go out of the edges (when there is an activated selection, all the operations modify only that area), then with the airbrush start to work as if it was a work on paper. To get a good result you have to hold a level of very low pressure, otherwise the nuances will appear rough. Alternate this tool to the brush when you want neater signs, change often dimension according to the area. When you make a mistake, return back in the history of one or more actions. If you go out of the inks you can cancel with the tool eraser. 











	 

	Remember to always work on the correct layer: don't colour the dark of the face on the layer of the jacket! For the background create another level and fill it with a gradient, I have used a radial type. Carefully choose your shades, with the computer it is easy to choose sour colors or too bright ones, considering that all are available with a click... have good taste and be sober. 

At this point we can add effects and details; for example, the fire of the cigar: create a new layer under the inks and paint with brush and airbrush the interested part. This however, is not sufficient because your cigar doesn't seem to shine. Create therefore a further new layer to be set above all the others, also to the inks; here, with the airbrush, using a level of low pressure, create the halo of light orange. If the shine seems excessive you can make it more transparent by regulating the opacity, - slider on the palette layers -. This very important function rules the transparency of that level and it will be always very useful. We notice that we have had to make an operation above the inks, putting a layer above these. In this way the multiply command doesn't have effect: it influences only the underlying layers. 





	 

	Let's pass to the background. Up to now it is a little too flat, let's move it with a texture that simulates a scraped wall. To do this we will use a combination of filters. By combining the filters, a lot of effects can be obtained, try to believe. 








	 

	Start creating a new layer, and position it above that of the background, that is the second from the lower part, in this way, you will work behind the whole figure and you won't have to take care of not going above it. Select the airbrush and "bleach" the wall in irregular way, almost totally. This is our initial material that we will turn into a scraped wall. We now apply the first filter, a noise - filter_noise_add noise -. Let's blur slightly our noise - filter_blur_gaussian blur -, we now apply the effect emboss - filter_stylize_emboss -. Regulate this effect so that to create a surface similar to a rough rock. We are almost to the aim. We now need to fuse this layer with the background: go to the zone of selection of the blending mode, beside the opacity, and select overlay. Now, erase slightly the bump effect just created so that it amalgamates better with the rest. Also the eraser has to have a level of very low opacity; on the other hand the dimension can also be great. You can add a sense of profundity scaling the level - edit_transform_scale -; obviously in this case you will have to soften the neat borders that result. If you are not yet satisfied you can duplicate your layer and position it again with the tool move, so that to enrich the total. Frogman now starts to seem quite a lot sinister, but with a shade at his shoulders it will seem even more. Create a new layer, always under the character; now with the airbrush paint the shade that will also contribute to the determination of the space. 





	 

	Now you can add a writing: select the tool text, click where you want to write and write what you like. Now select what you have written and choose a font at your pleasure; I have chosen the analog. At this point click twice on the layer containing the text: it will open the window of the effects; select stroke, to apply a contour, select a color and the thickness (2 or 3 pixels). Then I have applied the effects bevel and emboss and drop shadow. 
Try all the effects, and see what they produce. There will be very useful, and keep in mind that they can be applied to any level, not only to those of text. Once chosen the effects you can make the writing semitransparent by regulating the opacity with the usual slider. The blurred writings can be obtained by duplicating the layer, removing the effects that you have just put, moving it in the desired position with the tool move and applying the filter Gaussian blur and motion blur. You can also alter the dimension by using the command scale and the transparency by setting the opacity. Create a balanced composition by duplicating many times the writing. 


You can simply add then some cracks by drawing them on a new layer with a small pointed brush, then by applying emboss, and finally by blurring slightly the whole. If they detach too much, lower the opacity. 





	 

	Well, our image can be considered finished. Always save the file on more layers, but also a flat one, that occupies less space and results therefore more "manageable": perform - layer_flatten image - and then save apart. You now have the two definitive copies of your File. 

But it doesn't end here. Now that the work is finished we will realize some variations, you will see how easy and fast is to bring important changes to your work. 

	 

	To alter the color. Frogman, as you have certainly realized, is a mafia boss changed in a frog man, coming from a comic strip of science fiction. Then it seems legitimate to believe that the color of its skin has to be a beautiful green olive: take your file on layers, select that of the complexion and perform the command - image_adjust_hue/saturation -. Change the hue with the related slider. If the color is too strongly de-saturate it a little. If the result doesn't satisfy you, use the commands in the same menu color balance and brightness/contrast. What we have done is a very useful operation to correct shades that you have just realized and of which you are not satisfied. We have now used these commands a little too strongly, but they can be always useful for small adjustments and optimizations. 





	 

	We bring another change: we give the image an ancient look: our mutated friend becomes a gangster of the 30s. Merge all the layers, then remove the whole saturation - image_adjust_desaturate -, at this point open the window color balance and slightly move the sliders increasing the red and the yellow in the shades and in the midtones. Try to get a good cuttlefish or blood tonality. Save your work. 





	 

	Here is another way of post-producing the image: let's create the "fast ghosts" (futurist definition...) around our character, to realize a composition with the same method of the transparent writings. We merge all the layers containing the color of our character, then we duplicate the resulted layer, bring it behind the original one, and apply the filter - blur_motion blur -. We regulate its position with move and we adjust the opacity. We duplicate the "ghost" many times and position it to create a balanced composition as in the photo. Save the work. 






How to use Vectorial Design software
At the basis of the 2d computer image, we have the so-called vectorial graphic, a drawing system that allows the use of geometrical tools to draw precise lines and shapes combined together, that remain unvaried no matter what scaling is used. The most known software of this kind are Freehand, Illustrator and Corel Draw. 

But n these section we mostly deal with the field of the interactive image and animation developed for the web, works of art born to live on the screen, as for example the ones created with the software called Flash. These images must be conceived as “open works”, within whose project the foreseen participation of the user should be fundamental.
	Macromedia Flash 

This tutorial illustrates, through 3 exercises, some key passages of the realization of an interactive Image, Labyrinth.

You don't need to have any knowledge of the software to follow the section Beginners. In the section two segments of the realization are explained step by step. 
The section for experienced users is an overview about the devices used to realize the total model of reference: here you won't find step by step tutorials, but an exchange of experience. It's a matter of answering to some hypothetical questions that could be born in the experienced mind when seeing the model of reference.
 Beginners: 
1: How to create animated buttons 
2 : How to create Alpha level tones and animate them 
Experienced users: 
Steps of realization of the model of reference 
 

	


Beginners
1 : how to create red the indication 
Create animated buttons
 

Open a new movie (File>New )
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Modify the properties of the movie (Modify>Movie) with the values: 
Frame rate: 16 f/ps (16 frames per second) 
Dimensions 740*450 pixels 
Background color : Black 

At this point we have our space of work. 

For first thing we create the indication of the point in which it is possible to enter the labyrinth. 
You are positioned on the frame 1 of level 1, Scene 1 of your movie.
Let's recall the text-options from the toolbar 
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by clicking right at the bottom the symbol "A"
or 
Vindow > Panels > Character 

Then we choose a font and a color for the writing. 

We now select the tool text [image: image18.png](NE )
N O



from the toolbar and we compose a writing we like 
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At this point we select the text with the tool arrow [image: image20.png]


, and we convert it in symbol/button. 
To convert in symbol once selected: 
Insert > convert to symbol (F8) 
In the screenshot that appears, select Button, give a name you like (for us testo1), therefore give Ok. 

[image: image21.png]Neme: fistat oK

Behavior: € Movie Clp Cancel
e
© Graphic






At this point select with [image: image22.png]


the symbol, then: 
click with the second and select edit
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or 
Edit > Edit symbols 
or 
Ctrl+E
In screenshot that appears, select the frame "Hit" 
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and insert a key frame: 
Press F6
or
Insert > Keyframe 

Once inserted the key frame[image: image25.png]3E!




:
- select the frame 
-select the text and cancel it 
-draw with the rectangle tool [image: image26.png]


a rectangle that occupies the same space, as in figure: 
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This rectangle will be invisible for the user, but it determines the sensitive surface ("Hit") to the entry of the cursor of the mouse. 

Our task is now to insert an animation that will be visible when the user enters the zone delimited by the rectangle that we have drawn, that is when he gets closer and place the cursor of the mouse above the text that we have composed (currently situated on the frame "Up", that is the way in which the button appears when it is quiet, when the user doesn't interact with it). 
To give an animation to the button when the user passes above it, we have to intervene on the frame "Over", whose content is visualized when the arrow of the mouse passes on the sensitive zone that we have delineated ("Hit"). 
Now select the frame Over 
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And insert another key frame (F6). 
Now select the text (we are always in the frame Over) 
and convert it in symbol (F8). 
In the screenshot that appears select MovieClip and give a name you want (for us testo1_over). 
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At this point select the text of the frame Over, that has become a MovieClip (Filmed Clip) and press Edit (Ctrl+E

We are in the movie clip now, that is a Timeline (temporal Line) independent from the principal movie, that follows its own rules of reproduction and that we can associate to an event, which is exactly what we are doing. 
 

	 

Let's create an animation
We select the frame 15 and we insert a frame (F5 or insert>frame). In this way our animation will last 15 frames. 
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We now select our text and cancel it, and we draw a geometric figure at its place (in this case a rectangle): 
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We now proceed to animate it: 

Insert > Create Motion Tween 
or
Select the frame 1 and with the second key select "Create Motion Tween" 
 

The bar of the frames should be light blue.
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Now insert a key frame (F6) to the last frame. 

We are in the frame 15, we move with the tool arrow [image: image33.png]


the rectangle toward right. Now, if we place ourselves on the frame 1 and press Enter on our keyboard, we can see our animation. 
You can modify as you want the position of the object to the frame 15, the software will automatically draw the intermediary frames. You can also add intermediary key frames (for example, by pressing F6 to the frame 7) to insert some intermediary positions to the animation (in the model of reference the object rotates upward).
In all the cases what you will get is that the software draws the lacking frames following the run of the straight line that connects the frame of departure (frame key number 1) to that of arrival (frame key number 2).
 


 


SIf we want to add a fading in black, as happens in the model of reference, we resort to the effects: 
Select the object on the frame 15. 
Recall the panel of the effects: 
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Press where indicated 
or 
Window > panels > effect 
Select the Alpha (transparency) from the Curtain menu 
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Bring the value on 0% 

[image: image36.png]




Our rectangle is now transparent in the frame of arrival. The result of the animation is a fading in black. 
We now return to the scene 1, that is to the movie that contains the button, that contains in turn, in the frame "Over", the animation that we have composed. 
We now publish our movie: 
After having saved it (if you have not done it yet) 
-press CTRL+SHIFT+F12 
or 
-File> Publish settings 
A panel with the options of publication should open. 
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If you want to visualize the file with your browser (have you installed the Plug-in?) select Flash (. swf) and Html (. html). 
Press OK, go to the folder where you have saved the movie and open NameYourMovie.html 
Your browser will open and you will see the movie. 

If you have installed on your computer Macromedia © Flash Player, you can also export only Flash, and open the file .swf in your folder. 

If you want to create a file to be transported on computers that don't have any devices to visualize flash or you have problems with visualization, you can create a projector (Windows or Mac) that is an executable (. exe) that weighs more than the simple movie because it also contains the program of visualization. The advantage is that it works independently from the condition of the computer on which it is made to run (if you have to produce a cd-rom to be distributed, it is for example worthwhile to export as projector,). Whoever will receive your cd-rom, he/she will see your work by opening the file in it contained, without needing to download anything from Internet. 
	We remember: 

 

To acquire the basic abilities for using the program, you simply to open the program and follow the inside lessons. 
To do it: 
- Open the program 
- Click on Help > Lessons 
- Follow the lessons from the number 01 to the number 08. 

 




	 

	 

Beginners
2 : How to create the effects of shade on the labyrinth 

How to create tones with a level Alpha, and to animate them 

This phase of the tutorial implies that you have already carried out the preceding one. Some abilities will be given for granted. 

We return to the saved movie that you have used in the preceding tutorial. 

In scene 1, we create a new level: 
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Press the indicated key 
or
Insert>Layer 

We draw in the new level a circle, as if it were the labyrinth. 
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We now create a third level that will contain the effects of light. 
We visualize the panels (Window>panels) Fill and Mixer 
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On the panel Fill, we choose from the descent menu Linear Gradient and at the two extreme we set a black color. 

We select then the cursor/tone on the right, and on the panel mixer we bring the value Alpha=0% 
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On the third level, still empty, we draw a rectangle [image: image42.png]


that covers partly the circle. 

We bring the level "testo1" (that with the animate button) higher than the other two, so that it doesn't receive the shade (to do it, drag the writing with the name of the level and bring it at the top). 
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Select the rectangle and convert it in symbol/Movie Clip (F8). 

We now select the rectangle that has become Movie clip. 

To edit it we can resort to the second key and select "Edit" but in this case it is better to use "Edit in Place", since the circle will be visible and we can verify the shadings. 

In the new timeline, we insert a frame (F5) at the number 240, for example, so that the shade will move slowly, during many frames. 

As we have seen for the rectangle of the preceding tutorial (chart create an animation) we can animate the shaded rectangle that simulates the light around the circle, by making it rotate with the tool rotate [image: image44.png]


in the toolbar so that it has the part of fading tone Alpha always turned toward the centre of the circle, and making it complete a circle through various intermediary frames key. 
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It is important that the first frame is identical to the last one; the MovieClip, in fact, once arrived at the end of its 240 frames will start back from the beginning, that is from the first frame. With two different frames a leap would be visible. 


Step for the advanced user 
Passages of realization of the model of reference 

In this section we describe the passages of realization of the model. The part of construction in Flash of the experience is technically rather simple. 
 

Scene 1, frame 1 (contains an action "Stop()")
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The labyrinth has the key at its centre. 
 

This is the graphic symbol of the labyrinth in scene 1. In it are contained: 
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-level 1: the image of the labyrinth (graphic). Notice that the image is square. The roundness is given by a mask in the scene 1. 
-level 2: a button (visible in light green), with the exact shape of the walls of the labyrinth. Its states are: OVER-the light blue shape that is seen when we come in contact with the walls. HIT: the same shape as Over. 
To the button this action is associated: 
on (rollOver) {
gotoAndStop (2);
}
 

This action brings the replay to Scena1, frame 2 
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that is that where the corridors of the labyrinth are dyed of blue, and the key disappears from the centre. This is the state in which the user find himself when he gets in contact with the walls of the labyrinth. The labyrinth remains blue and the key doesn't reappear until the moment in which he doesn't go out. 

The blue dye is a graphic symbol. 
When the user goes out of the circle, the rectangular invisible button that surrounds the labyrinth (in light green) recognises the fact. In fact this button has only a state HIT, with associated the action: 
on (rollOver) {
gotoAndStop (1);
}

that brings the action to the initial state (frame 1). 

If the user brings him to the centre of the labyrinth crossing the volutes of it, he can reach the key. 

It is a button with the sensitive zone extended to a rectangle, as you can see in this Onion skinning. 

[image: image49.jpg]




The action associated to this button is 
on (press) {
gotoAndPlay ("key");
}

Where Key is the Label after which there is the animation of the fading between the labyrinth and the iris of an eye. 

Both in the frame 1 and in the frame 2 you can find, on its level, a MovieClip with the effect of light on the labyrinth, given by a gradient that dissolves itself in Alpha in continuous rotation. 
Scena 1, Label Key:

During the fading between the labyrinth (what goes to Alpha) and the iris (situated in an underlying level) the key is this time a MovieClip with this action associated to it: 

onClipEvent (enterFrame) {
startDrag ("");
}
In fact during the animation the key follows the movements of the mouse. 
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Once reached the final frame (that has an action "Stop () "), the movie can be brought to the Flag "Key" since the key is again a button, with associated the action: 
on (press) {
gotoAndPlay ("key");
}
3D Image

The three-dimensional representation of an object through computer has been, since the years 70-80, one of the greatest challenges in the development of Information Technologies. With the carrying out of the solid modelling, a first fundamental objective has been achieved: virtual sculpture through computer. It doesn’t matter if at the beginning it only concerned technical products; soon other forms were taken into consideration, like architectural structures and anatomic forms at last.

The final aims of these technologies are more ambitious, like for example the covering of models mathematically created to render them as much similar to real objects as possible: the reproduction of the paints of the cars, of the hair and scales of animals, of building stones are still today a topic of studies and of development of new algorithms. All this combined with the work of placing these forms in a more and more realistic virtual environment, with shadows, lights, reflexes and transparency.
All these technologies, together with those of animation of the created models, are more and more used in the industry which is able to perfectly simulate the image and the working of a product which only exists virtually, in the movies, and with the creation of always new special effects, in the production of animation, films and interactive videogames whose characters are not bi-dimensionally designed, but drawn as if they were true and realistic, not only in their forms but also in the movements, gestures and even in the expression of their “faces”.

The amazing results obtained up to now by technology must be crowned by the most important objective; that of reproducing the human face with all the expressions of feelings and sensibility. It is obvious that many of the described representations require very expensive equipments and sophisticated technical competences, but the continuous technological development allows operating at high levels even with simple and cheap means.
The 3D image modelling process consists in the wire frame construction of an object structure trough computer aided design (CAD) tools, like the well known 3D Studio Max software. Once constructed this model can be moved and seen from different points of view as a “digital sculpture”.
This technique is the one that permits to reach the most stunning realistic effects. 
In the game design –also at an elementary level- most of the effect is reached using the technic of the “texture mapping”. 

The name texture mapping is given to the technique trough which it is possible to “paint” over a 3D wire frame model. It is possible to use real colours, but mostly little parts of photographic or drowned images (called textures) are used to reach an impressive realistic –or surrealistic- effect. Sticking the photograph of the skin of a lizard on the 3d model of a dinosaur makes it appear real.
The texture mapping technique is the most revolutionary and significative painting technique in the whole computer graphic field and it is at the basis of the realistic effect of the so-called virtual reality environments like in most of the better videogames . 
In the following section we treat some basics of it. 

How to create Texture Maps for 3D

	Every different 3D software has his own method to create texture maps, here we give an example using Autodesk 3DStudioMax
.

Before starting to build a three-dimensional model in 3DMax of a head, you need to have a front image and a lateral one of the head itself at low resolution (es. 320x240) in jpg format. 
 




1

1. Select "Viewport Backgroud" from the descent menu "Views". 
2. Select "Files..." to choose the image to be use as frontal background (ex. face.jpg)
3. Set "Aspect Ratio" on "Match Bitmap" and "Front" in Viewport. 
4. Use in a second moment "Lock Zoom/Pan" to put correctly the image inside the window. 

	 

 

 

	


2

1. From the panel "Create" select "shape" then "line." 
2. Set on "corner" both "Initial Type" and "Drag Type" 
3. Draw in the window "Front" the perimeter of the face and close the shape by making the end point coincide with the initial one. 

	 

 

 

	


3

1. From the panel "Modify" select from the descent menu the modifier "Extrude." 

	 

 

 

	


4

1. Make sure that the settings of "Extrude" correspond to those of figure 4. 

	 

 

 

	


5

1. From the panel "Modify" select from the descent menu "Edit Mesh" 
2. Select first the button "Face" and after all the faces of the "Mesh" 
3. Press Delete on the keyboard and at the question "Delete isolated vertices? " select "No". 

	 

 

 

	


6

1. Select the button "Vertex." 

	 

 

 

	


7

1. Select the button "Create" 
2. Create some vertices in correspondence to the key points of the morphology of the face (in this phase you need to imagine the points that will be subsequently moved so that to delineate the features of the face). 

	 

 

 

	


8

1. Select again the button "Face" and then "Create" 
2. By joining 3 vertexes at a time we will create some triangular faces that will form the surface of the visage. 
3. It is important to make sure that the faces created on the right and on the left of our visage are symmetrical enough as you can see in the figure 8. 

	 

 

 

	


9

1. The problems of visualization of the faces are due to the fact that we are probably seeing the non visible side of our triangle. In fact in the sofwares 3D a side of the polygon is usually visualized to lighten the calculation of the motor of rendering so that to make our operations quicker. 
2. To make up for the problems above you need: first of all, to make sure that the settings of visualization of the window Front correspond to those of figure 9 and you do it by pressing the right button of the mouse with the cursor positioned high on the left in correspondence to the writing "Front"; then you need to reverse the "normal" of the non visible faces in the window "Front" using the key "Flip" inside the panel "Surface Properties" in "Edit mesh". 

	 

 

 

	


10

1. Load and position in the window "Left" a background that refers to the side vision of the head (es. profile.jpg) using as before the descent menu "Viewport backgound".
2. Select the button "Vertex" and then the one "Select and move" in the "Main Toolbar". 
3. By using both the window "Left" and the "Front" one, select and move one or more vertices in correspondence to the feature of the visage in background on which we are working. 

	 

 

 

	


11

1. This operation is the one that summarizes at best the technique of "modeling 3D", that is how to manage to interpret a 3D object using 2 bidimensional images of the same object and connecting them. It is not only a matter of mere automatism, in this phase you will have to give wide space to your anatomical knowledges and sensitive experiences as it happens when you model -for example- the clay in the reality. 
2. During the modeling the window "Perspective"is very useful which gives the possibility to model the form directly in three dimensions. 


	 

 

 

	


12

1. By using the same method previously used, create some vertices in correspondence to the head and the nape so that to build the framework to complete the rest of the head (to clone one or more vertices select it and by holding shift pressed move it to the point in which you want to position the new vertex or vertices). 

	 

 

 


	


13

1.Now create the faces that will constitute the whole surface of the head, by joining all the vertices you have just created.

	 
 


	


14
1. According to the powers of our PC but above all to the further use of the 3D object we are considering it is possible to increase its definition and therefore the realism thanks to the modifier "Mesh Smooth" 
2. Select it from the descent menu of the panel "Modify" 
3. Set "Iterations" on 2 
4. The object is now ready to be submitted to "Texture Mapping." 


	 

 

 

	 





A very useful low polygon 3D software for using in game modeling and texturing is Milkshape 3D, a software expressly created for modeling 3D games characters:
http://www.swissquake.ch/chumbalum-soft/ms3d/download.html (download)

http://www.swissquake.ch/chumbalum-soft/ms3d/tutorials.html (tutorials)

Virtual Sets
Technical suggestion about the use of commercial Videogames for the realization of virtual spaces to be used as environments for customised adventures.

 

The commercial videogames can be used and edited also in indirect ways. Maybe that for creating a videogame, we need a virtual environment in wich set up an adventure. We can create a 3D environment with a 3D software, or we can arrange a photographic photo-set. Otherwise, we can make an hybrid between the two things, by creating a virtual set directly inside a commercial videogame. 

Below, you can see two examples of what it is possible to do by conceiving a 3D vedogame as a virtual set. The first example is from Call of Cthulhu. The game is an adventure where is possible to explore many different areas with very different environments. Furthermore, no weapon is visible in most of the game's levels.  

Using a software for capturing images and videos from videogames (as Fraps), we can capture a number of frames for creating a point&click 2D path. In this case, we have captured screens from the inside of a photography darkroom.
Call of Cthulhu
Those are part of the screenshot captured during the game...
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...then you can have a movie of the final result, after having arranged with Neobook the captured images in a 2D sequence, that can be used and enriched by adding hotspots and other hypermedial elements.
Obviously this isn't a finished game, but only an example of what it is possible to do using a commercial videogame as a virtual set for our poin & click customized adventure.

In the tutorial section of the Learningame portal you can download both the .pub file (the project) and the executable one, in a way that you can make your tests on the functioning of Neobook (See in the Software section of the portal). To work on the .pub file, simply open it with Neobook.
Golf
The second example is from Golf, a sport videogame that presents many editable 3D natural environment. The screenshots were captured with Fraps again, but this time we have built with them a beautiful 360 degree panorama, similar to what is possible to realize with a photo camera. The panorama was then used to create an interactive frame with Adventure Maker.
Below you can see some examples representing the singles shots taken by the game. 
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Always in the tutorial section of the site you can download the .zip file including the .exe application and the source file. For mounting correctly the source file you must have installed Adventure Maker: go into the Program folder of windows, go into Adventure Maker's Folder, and then copy our folder into the Projects folder. Now start the program and open the project named GOLF, enjoy.
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Note that the last two images are those mounted into the .exe created with Adventure Maker.
The first picture is the one resulting from the stitching of all the captured images, the second is the same picture but elaborated with Photoshop. Remember that (in Adventure Maker) the panoramas require a 2048x2048 image to be created, as you can see in the Adventure Maker Tutorial.

By launching the .exe file that you can download on the site, you can pass from the right panorama (made with the second square image) to the wrong one (made with the not elaborate image), so you can see the difference.
	Chapter Three:

How to Produce and Manage Animation with IT

In.For.Ef (BE)


1. How to create Gif Animation


1.1 Introduction

An animation consists in a series of framed images displayed one after the other to create the illusion of motion. Gif Animations, low-bandwidth animations which frequently decorate Web pages, follow this principle.

An animated GIF (Graphics Interchange Format, specified as GIF89a) is a single file that is composed of a series of individual still images, added to some timing information. Playing these images in sequence gives the effect of a motion: an object is moved by very small amounts between individually frames, producing the effect of motion when the series of frames is played back at normal speed.

GIF animations are easy to make: you use common available tools, programming is not necessary, no plug-ins are required to read them, and you use the common <IMG> HTML tag to display them on your web page. 

In this manual we’ll see how to create a GIF animation.


1.2 What you need

You'll need software to create your animations:

· A graphics program to create the individual images; for example Photoshop, Photopaint, or Photofiltre (freeware)...

· A GIF animation program to convert the different images into a single GIF89a file and add the timing information, and finally optimize it; for example Gif Movie Gear, or Gif Animator (freeware)…

Some programs, like Photoshop/Image Ready, include both functions so you may not need separate programs. 


1.3 Frames and Timing 

Animated GIF is a frame-by-frame animation, this mean that we have series of individual still images. The animation is in fact an illusion of movement, created by the rapid display of the sequence of images. 

The number of frames by second of the animation has an impact on the smoothness of the animation and on the size of the file. Too many frames make the file bigger and slower to download (and require more work to make the drawings!). Few frames make the animation appear rough.

The goal is to pick the minimum number of images necessary to accomplish the desired motion.  It’s quite difficult to anticipate the correct difference between two drawings. This work requires a minimum of testing… Selecting the right number of frames takes some experience and mental visualization!

One thing to know is that the timing doesn’t have to be uniform. You can set each frame independently, for example one frame may display for only a quarter of a second, the next to 5 seconds. The right number of frames and timing will depend a lot on what you are animating. 

It may help to make a storyboard of the animation, consisting in a rough sketch of each image. Don't worry about getting exactly the number of frames and the right time, you can add or subtract frames later. 

If you plan your animation not to loop, just play it one and then stop. The last frame is what will remain on the screen. Make sure it is what you want to be seen! 

You can also make an animation disappear at the end of its cycle, or somewhere in the middle, by including a transparent image.


1.4 First, select the animation dimensions 

Decide the overall width and height you want the animation to be. The largest the dimensions are, the slowest the animation will download. So keep it as small as possible while you maintain the effect you want to achieve. 

We will create an example with Photoshop and Illustrator.

I decide that my animation will be 200x200 pixels.


1.5 Creation of the drawing 

Once you’ve selected a size, draw each image of the animation as a full size image at these same dimensions.

I draw in Photoshop the element I want to animate. This drawing will become the first frame of my animated GIF:

[image: image175.jpg]



Then I draw on separate layers the different steps of my animation.

In this example, I have drawn 20 images. In a first approach we could imagine that it will be enough.
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After that, it’s time to use the animation program. In our case, it will be “Image Ready”. A button allows that: 


1.6 Steps of the animation.

In “Image Ready” you work with three windows: the Photoshop document, the Animation palette and the Layers palette. (If the Animation palette doesn’t appear: select Window > Animation from the main menu)

At first, your animation has only one frame, which corresponds to the visible layer. So you have to select each layer one by one, and assign them one by one as a new frame of the animation:

[image: image177.emf]
Click on the Duplicate Current Frame icon (1) in the Animation palette to add one more frame. 

You need to let Image Ready know what layer to display for each frame of the animation. Click on the second animation frame icon in the Animation palette to select it and then turn the visibility of your second text layer on in the Layers palette. 

Click the third animation frame icon in the Animation palette to select it and then turn the visibility of your second and third text layers on in the Layers palette. And so on for each layer…
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Here are the pictures I used: 
[image: image79.jpg]ce000® 0 S RS

s 0mes  Omec  Omec  Omec  Omec  Omec  Omec  Omas  Omoc

990000000

e R s e D s T R e




Next, you need to set the duration each frame will be played (4). 
Choose if you want your animation to loop or not. If you don’t want it to loop, select how long it must be played (5).
Preview your animation by clicking the Play button (6) at the bottom of the Animation palette.

At this moment, you can add or remove frame, change the duration of each frame…


1.7 Saving your animation

From the main menu select File > Save Optimised As. This will give you the possibility to save it as an animated GIF and/or to save it as an HTML page. For a simple animation, just save as a GIF.

You can also select File > Export, which gives you some additional options such as exporting as a Flash file (.swf) or a Quicktime Movie (.mov).

If you just save the file, it will be saved as a layered Photoshop file (.psd), so you can reedit it.

2. How to create Vectorial Animation (eg. Flash)


2.1 Introduction 

Before learning about vectorial animation, we have to make the difference between the two types of 2D Graphics: 

· Bitmap pictures: created with software like Photoshop (Adobe) or Painter (Corel). They can also be scanned photographies. 

Bitmap images are made up of pixels in a grid. Pixels are picture elements, tiny dots of individual colour that make up what you see on your screen. 

· Vectorial pictures: created with software like Illustrator, Flash or Freehand (Adobe)... 

Vector images are made up of many individual, scalable objects. These objects are defined by mathematical equations rather than pixels, so they are always rendered with the highest quality. Objects may consist of lines, curves, and shapes with editable attributes such as colour, fill, and outline. Changing the attributes of a vector object does not affect the object itself. You can freely change any number of object attributes without destroying the basic object. An object can be modified not only by changing its attributes, but also by shaping and transforming it using nodes and control handles.

In the old days of animation, in order to make something look like it was moving, an illustrator or animator would have to draw a lot of different pictures, each one similar to the previous, but changed in just a small way, similar to how a flip book works. (See ‘how to create an animated gif’ above.) This was known as in-betweening (later shortened to tweening) because they had to draw all of the frames in-between the start and end point of the animation.

In vectorial animation software you don’t have to draw all of these in-between pictures. You only have to draw more or less the starting point of your moving object, and the ending point. The rest is done by the program! 


2.2 Basic animation  

Motion tween is nothing but tweening a Symbol's movement from one position to another.

Let’s take an example: we want to move a circle: 

To implement motion tween all that you have to do is provide Flash with symbol's initial position (first circle) and the end position (last circle). Intermediate tweening (the light blue circles) is done by the software.

We understand now how vectorial animations files can be so light!
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2.3 Guided animation 

It is possible to create a simple movement by drawing a line which the symbol will follow.

This line is called ‘way’.
[image: image80.emf]

2.4 3D effect 

It is possible, thanks to the vectorial animation, to realize a 3D effect. For that, you just have to change the picture’s size: we delimit the starting size and the ending size and, here again, the software will automatically generate by interpolation the buffer pictures. (Here, the big circle seems to be nearer that the small circle)

[image: image81.emf]

2.5 Morphing 

We’ve just seen that we can move a picture.

We can also apply this rule of animation to several points of a simple shape. As a result, we can make a morphing (modification of the shape)

In this example, a blue circle (starting point) will become a yellow square (ending point), with all the transitions computed by the software!
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2.6 Flash

Those vectorial animations can be created with the software ‘Flash’.

Flash animations are graphs and vectorial interactive animations mainly intended to Website but more and more used to create some ‘little’ cartoons. These animations could contain pictures (JPG, GIF) as well vectorial drawings, some texts or sounds. 

By using vectorial picture and streaming, Flash allows the realisation of advanced and interactive animations, while preserving the fastness of downloading and the user’s comfort. 

To read these animations, a ‘Flash Player’ is needed. It’s a free plug-in available on the adobe website. You just have to set it up on your computer and after that, the animations will run in the browser like an independent application. But Flash animations are so current, that the Flash player is already present in mainly personal computers!

With Flash you can animate frame by frame or by using tweening… or by combining both techniques.


2.7 Using of Flash

· First in the centre of your screen is the stage. There you can add shapes or various other things, and edit the graphics of your animation. 
All things you put on the stage is what will be displayed in your final published animation.

· On the left side of the Flash interface, you will see the Toolbox. This is familiar to almost every designing program. It allows you to draw circles, squares, move stuff around, resize shapes, and do all kinds of things… 

· At the very top of the screen, you have the Timeline. This is where the main action goes on in Flash. You can add frames, layers... 
Flash recognizes two different types of frames: frames and keyframe. 
- 
Keyframes are the important frames: the frames you designate to hold distinct images
- 
Frames contain whatever image you associated with the last keyframe: their purpose is to mark time. 

· In frame by frame animations, most of the frames you create are keyframes.

· On the right hand side of the screen, you will notice a few panels, including the library, where all your objects are stored. Those objects can be symbols, sounds, imported pictures…

· At the bottom of your screen is a panel with a few tabs: the properties tab that will contain various properties of your symbols, shapes, tweens, texts... 

· You also have the actions panel. This is where more advanced coding known as actionscript goes on for your projects. 

· To build an animation, you can use Flash’s drawing tools to draw the content of each frame on the stage, or you can import existing pictures; you place a picture in each keyframe you create. You can also use the Symbols stored in the library.
· Symbols and instances :

If you want to reuse a drawing, you should save it in Flash as a Symbol.

Symbols help to keep your animation’s finished file size down to a bare minimum. When you create a symbol, Flash stores the piece of information for the symbol in your document as usual. But every time you create a copy (= instance) of that symbol, all that Flash adds to your file is the little bit of information it needs to keep track of where you positioned that instance, its size...

The advantage of using symbol is not only the file optimization, but also the instantaneous update: when you edit the symbol, Flash automatically updates all the instances of that symbol on the stage! But you can also make some changes (the height, deformations…) of each instance separately…

Flash lets you create three different types of symbols: graphic symbols, movie clip symbols, and button symbols. A symbol can also contain other symbols, especially movie clips, which are symbols having their own timeline, independently from the main timeline.

Here is an example of a tutorial realized for this project, showing how to make an animation with Flash:

http://learningame.inforef.be/tutoriaux/flash.html
You’ll see that this software is not so easy to use. If you are already familiar with other animation or multimedia software, it will be easier, otherwise some efforts and perseverance will be necessary. 

But all the possibilities of such software will make your learning really exciting!

3. How to create Morphing Animation


3.1 Introduction

Image morphing is a visualization technique. It is often used for educational or entertaining purposes.

Image morphing techniques have been widely used in creating special effects for television commercials, music videos such as Michael Jackson's “Black or White”, and movies such as “Willow” and “Indiana Jones and the Last Crusade”. 

It’s an image processing technique used to compute a transformation, that is, a metamorphosis from one image to another. The idea is to create a sequence of intermediate images, which when put together with the original images, represents the transition from one image to the other.

The morphed pictures in sequence can be shown as a dynamic process like a movie. The result can be very interesting.

In a morphing sequence between two faces, the middle picture often looks strikingly lifelike, as a real person, but clearly it is neither the person in the first or in the second image. 

Morphing between two images achieves the best results if the images are roughly of the same shape and colors, e.g. morphing from a tree to a cat may not result in such a good transition as when morphing from one face to another. In this case the middle image might look strange since it got no equivalence in the real world. 

You have several morphing software, but the principle is always the same: you choose a starting and an ending picture, and you place key dots on both source images in order to define how the morph process will operate. With this principle you can also create morphing with other software, as Flash…

In the following of this manual, we will see how to create a morphing animation with a software called Fantamorph. 

Note: 
You can also create advanced morphing with 3d software. The principle is different: with 3d software, you cannot morph an object into a completely different object, because your initial object and your morph target must have the same numbered vertices.


3.2 Abrasoft FantaMorph Tutorial : Starting a project

An easy way for beginners to do morph is to use ‘the New Project Wizard’: 

1. On the welcome window, you can choose one task from "Open an existing project" or "Create a new project". (If you don't want to use the wizard at startup of the program, just check the "Don't show this wizard again". You can still launch the wizard by choosing the File>New Project Wizard menu at any time.) To go to the next step, just click the ‘next’ button.
2. Choose the project type you want to create. We choose to create a morph.
[image: image180.png]



[image: image181.jpg]



[image: image182.png]



3. We begin by selecting two images to morph, a beginning image and a final image. 
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4. Now you can crop or adjust source images if needed. (Just press "Next" button to bypass this step.) 
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For a best rendering, we often have to crop one image to adjust it to the other, a.s.o... We can make it with the program: 
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Do the same with image 2. 

5. [image: image184.jpg]


Now you need to set the movie size and length. You can choose any fixed value offered in the Movie Size list, or you may set it to any desired value by choosing the button "Set Custom Size". The default frame count value is 15, if you want a smoother, more detailed morph result, simply add more frames. If you want to set the movie length by duration, just click the "Set Duration" button.
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6. You can add some stunning effects for your morph.

You can choose some existing feature (the program proposes some background, foreground...), or you can create some effect yourself, by using Photoshop for example. A mask makes a part of the picture transparent, so you can apply a background, and it will appear. (the mask will be applied on the image and if you apply a background, the back zone of the mask will become transparent and will let appear the background) .
7. Now, click the "Finish" button to exit the wizard. The morph movie has been now created. 
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You can see in the first frame the original picture, in the second frame the picture destination, and in the third frame the morph movie. 

Because you haven’t added any key dots yet, the morph is simply a cross-dissolve between the two source images. 

You now have to start the most important work that is to place key dots on both source images in order to define how the morph process will operate.


If you don't want to use the wizard, all those steps can be done manually. You can import the source images by choosing File>Import Image 1... in the menu, then File>Import Image 2..., or by clicking the Import Image buttons (1 and 2) 
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Any feature you have chosen with the wizard, you can load them manually. Let's see the tools:

[image: image186.jpg]


1: Import Image button
2: name of the image 
3: size of the image (pixels) 
4: location (x and y) of the cursor. It corresponds to the image you see in the zoom 8 
5: size of the window. You can adjust the percentage of visualisation of the image. (you can zoom in, zoom out, adjust...) 
6: Crop Image button (open the same dialog box than with the wizzard) 
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7: Adjust image button (open the same dialog box than with the wizzard)

You can also choose a background, a mask... as in the project wizard. Once you have chosen, you can display or not by clicking once, if you click twice you can change load another feature... A right-click on the feature you have loaded and it disappear. 

Notice: For an optimal result, you'd better optimize the images first in Photoshop. 

Remember that the most important element in producing morphs, whatever the software you’re using, is to place key dots on both source images in order to define how the morph process will operate. So let's place dots. 


3.3 Adding dots.

The principle is to place key dots on both source images in order to define how the morph process will operate.

Let's see the tools: 

[image: image188.jpg]


1: Edit tools: You can select dots, add a key dot (+); delete a dey dot (-)... Notice that you can also delete a dot with any tool selected by right-clicking on the dot. So, most of the time you have the (+) tool selected. With it you can add a new one by clicking anywhere on the image, you can delete and you can move dots.

 2: Auto add corresponding dot: with this tool selected, when you add a dot in an image, another appears automatically on the other image. If this option not selected, you have to click on the other image to place it. If this option is checked, for each click on either image, a corresponding dot will appear automatically on the opposite image. Generally, the automatically added dot is not located at the correct position, so you have to drag it to the position corresponding to the partner dot's location.

3: Auto Jump to Corresponding Dot: If this option is checked, when you added a dot on an image, the mouse cursor will automatically jump to corresponding position on the opposite image.

4: view tools: Adjust Viewport; zoom in and zoom out.

5: Zoom/Pan Sources Simultaneously: When you zoom/pan any one of the two source images, the program will zoom/pan the other one simultaneously.

6: Zoom/Pan Preview Simultaneously: When you zoom/pan any one of the two source images, the program will zoom/pan the preview simultaneously
Notice that in most cases, it is recommended to make both the options checked. In this way all windows can be located at the same position automatically.

7: The Magnifier: magnifies the area under and around the mouse cursor when you are working within the source or target image. This enables you to have good precision on delicate operation such as adjustment without having to zoom in and out continuously.

Let's begin with our photos:
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This time to work with Photoshop retouched photos: cut out faces with transparent background (the background will be loaded as an external file).

· 
As we’ve said, it's good to place dots on the major elements of a morphing image; in this example, the major elements are eyes, nose, mouth... (NB: In FantaMorph Deluxe, a "Face Locator" button will appear on this page. It helps you to automatically place key dots on images of human face.)

Let's put keys on those elements:

· Confirm that the edit tool Add Dot + is selected, then move mouse to the corner of the eye.

· Click the left mouse button. A dot will appear on image 1, and a corresponding dot will appear on image 2. Move the corresponding dot to a suitable position. The Magnifier (7) will help you. If you don't see where the corresponding dot is on the other image, just rollover the dot and it will appear in white on the other image.
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· Add other dots for the remaining corners of both eyes. The more dots you place on the elements of your image, the better your morph result will be, so feel free to continue adding dots to further define the eye shapes.

Notice that the movie morph will change accordingly as each key dot is created or moved!
· You can help yourself with the preview tools. Notice that with this software, you don't have to make any render to visualize your final morph, you will immediately see it...
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1. You can choose the Movie Size. The default value is the same size as Image 1. You can choose any fixed value offered in the popup menu, but as I said it's better to work witimages which have already the same size...

2. You can adjust the percentage of visualisation of the morph. (you can zoom in, zoom out, adjust...)

3. The most important control is the Preview Slider Bar. Each morph frame from the first to the last can be previewed easily by simply dragging the Preview Slider. For example, if you position the slider at the centre, you will preview the frame representing the middle of the morph. If you position the slider all the way to the right, you will preview the final frame of the morph, which is essentially Image 2. 

4. The Current Frame box

5. The Movie Frames box

If you want a smoother, more detailed morph result, simply add more frames: click, input a new frame count and press the Enter key; or click the Movie Frames Spin Button to increase or decrease the frame count by one 

6. Auto loop: the morph will repeatedly play until you press the Pause

7. Auto play all (used with sequences) 

8. Auto Reverse: make the morph cycle from start to end, then reverse from end to start.

9. Auto Switch (used with sequences)

10. This is the control panel: Play/Pause button, previous frame, next frame, jump to the first and to the last frame buttons.
· Do the same with the eyebrows, the mouse, the nose etc. And you will see the movie morph little by little become nicer. 
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· Then the contour of the face, the shoulders, the hairs... 
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· Let's see the result:

[image: image89.jpg]



· Now you have to export your movie!
3.4 Exporting the movie

You can export only some frame, or the whole morphing. 

Choose File\Export Current Frame... or File\Export movie... menu, or use the toolbar beside the preview box: 
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1 Export Current Frame

2 Export Movie: In most cases, movie is what you’ll choose
3 Export Options

· To export a frame, drag the preview slider to the position indicating the image you want to export, and choose a name and an image format. 
· To export the movie: 

First choose one of the 7 export methods available: Image Sequence, AVI Movie, Animated GIF, Flash Movie, Web Page, Screen Saver and Standalone EXE. Then, adjust the export parameters by clicking the Export Options button. 
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In the Movie Export Window, click on the format you've chosen, and click the "Export" button to start export...
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... And "Open" to see your movie... 
	Chapter Four:

How to Produce and Manage Video with IT

In.For.Ef (BE)


1. How to record and digitalize video

To record video you first need a video camera: an analog or a digital one.
· Analog camcorder records information in an analogical form (VHS, TV, Hi8, 8mm).

· Digital camcorder records information in a digital compressed format (DV: miniDV, digital8; HDV, DVD…)
- To edit analog video, you have to convert it into digital video. To make this conversion, you need a high-end graphics card, a separate capture card or a capture device for your computer.

- All the numerical camcorder record the video contents in numerical formats, but these contents must be captured (transferred on a disc) before being able to be used in an editing video software, like Adobe Premiere Pro.

Capturing video is the procedure you will use to get media clips from your digital camera into the computer to edit.
Here are the steps to import the video in a piece of Video Editing Software:
· Launch your video editing software

· Set up the right settings:


- Video Input > DV input 
- Video Format > Video Standard: PAL

· Connect a DV camcorder to the computer:

· Connect the 4 pin end of the Firewire cable to the DV camera. (On some camcorder this is marked DV IN/OUT.) 

· Connect the 6 pin end of the Firewire cable to the computer's Firewire port. (The camera should now display "DV IN" on the LCD screen.) 

· Capturing video:

· Make sure that the camera is turned on, loaded with the right tape and set to VCR mode. 

· Open the capture window by clicking: File > Capture > Movie Capture. 

· Preview your video on the VCR or camera and decide on exactly what segment you want to capture. Rewind a few seconds before the beginning of where you want your video to start so you won't miss the beginning. 

· Click on Record in the Movie Capture window and press Play on the DV camera/player. 

· When you’ve captured enough video, hit the Escape key on the keyboard. A new window will open with your newly captured clip. 

· Importing Media Files into your Project: Usual video editing software support a wide variety of media formats, including many types of audio and video, as well as still images and animations. 
To import media files:
- Select File > Import > File. 

- Select a file, and click Open. 

The file will be added. 

You can now edit your video.

2. How to edit digital video

2.1 Introduction

To edit your video you need a Video Editing Software.

The principle of editing is currently the same in each software, some provide more or less options. Good video editing software provide you the tools needed to capture, edit and share your video creations. 
With the most functional programs you can:

Capture video

· Upload video files in popular formats like video from players such as Windows Media Player, QuickTime and RealVideo.

· Capture video from digital recorders, the best can capture video from DV, HDV and analog camcorders as well as from digital and PC cameras.

· Capture video from traditional entertainment formats, like analog TV and VCR recording with the right hardware.

Edit video

· Rearrange, mix or combine video… with timeline editing you can drag & drop video clips or files to where you want them to be.

· Add titles, menus and text to your video creations. Many programs come with numerous menu and title templates and let you add text effects.

· Add music, narration or sound effects. 

· …

Share video

· Post online: easily post to your video blog or to YouTube, Google Video or any other video sites.

· Burn to DVD, create marketing presentations or archive your collection onto DVD or Blu-ray disc.

Here is we will explain how to edit video with Adobe Premiere.

2.2 Adobe Premiere Tutorial: Starting a Project

Adobe Premiere is a powerful video editing software. 
The first step to editing video in Premiere is to create a project file. A Project file is a Premiere file that stores references to all of your media clips and information about how you arranged and edited the clips. All what you use in your project will be accessible and organized in the Project Window.

2.2.1 To create a new Project

· The New Project dialog box appears when you launch Premiere. 

· If not, choose File > New > Project. 
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· Choose a preset and a directory.

If you're not sure of the preset choose DV-PAL this is the format for European camcorders.

It's better to create a new directory just for your project in which you will copy or record all the media you will use, so that the component files don't get lost or deleted. 

· Enter a Name for the project. 

· Click OK to begin working on your project.

2.2.2 Capturing video

First connect the camcorder to the computer (see chapter 1 how to proceed).

Capturing video is the procedure you will use to get media clips from your camera into the computer to edit.

· Choose File > Capture (or the F5 shortcut).
· The capture dialog box appears.
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· The window allows to capture Audio and Video, or just Audio or just Video. 

· This window takes over control of your digital camera. You can play back, rewind, use shuttle to move back/forward, move by single frame...

· Capture with the red button and stop with Escape. 

· Once you stopped recording, you will be prompted to save the file. 

· After that your clip is in the bin.
2.2.3 Importing Media Files into your Project
Premiere supports a wide variety of media formats, including many types of audio and video, as well as still images and animations. To import media files:

· Select File > Import... (or the Control+I shortcut) 

· Select a file, and click Open. 
· The file will be added to your Project window. 

· You can organize the imported media by dragging it into a specific bin in the Project Window. 

· Importing the folder will create a new bin with the same name. 

The files appear in the Project window. For each file that you import, the Project window lists its name, type, and duration. Other columns let you add your own descriptions or labels. You can scroll or enlarge the window if necessary.

2.3 The Premiere Workspace
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2.3.1 The Monitor

[image: image193.jpg]



The monitor is set up like the two-screen platform of a video editing deck.

· Source view 1 (on the left side of the window) lets you preview a clip, trim it, and then insert it into the Timeline window. This view can store many clips at a time, but you can view and trim only one clip at a time.

· Program view 2 (on the right) lets you preview your entire video program, at any time. This view displays the sequence of clips currently in the Timeline window. You can also use the Program view to edit your video program.

The advantage of the two-screen system is that you can manipulate a clip in the source screen and then play the timeline to see how the changes look in the overall project. 
2.3.2 The Project Window 

The files you've imported appear in the Project window. For each file that you import, the Project window lists its name, type, and duration. Other columns let you add your own descriptions or labels. You can scroll or enlarge the window if necessary.
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The Project window organizes and accesses all of the source material contained in your project. Bins are sub-folders within your project that are used for organizing media clips. (A clip can be digitized film, video, audio, a still image, or sequence of still images.)
In a large project it is convenient to create a different bin for each type of media or for different categories of camera shots. 

To create a new Bin:

· Select Project > Create > Bin, or click the icon new bin below the project window. 

· Enter a name for your bin and click OK. 

· You can now drag clips into your bin, or capture them directly to it. (Moving clips between different bins will not affect their place on the Timeline...)

You can work with any of the clips contained in the Project window simply by dragging them into the Timeline or Monitor.

2.3.3 [image: image194.jpg]


The Timeline 

The Timeline is where you compile and edit your clips to form your movie. The Timeline also provides an overview of your video layout, showing you where certain clips end and others begin, where transitions are located, etc.

The Timeline graphically shows the placement of each clip in time, its duration, and its relationship to the other clips in the program.

2.4 Editing Video 

2.4.1The Rough Cut

To get started on your project, you may want to create a rough cut of your video program. A rough cut is simply a sequence of clips assembled in the general sequence you want, with little or no editing.

A rough cut can quickly give you some sense of your video program’s effeciency, letting you start making decisions about where to cut, trim, and add transitions and special effects.

The clips you've imported do not become part of the video program until you place them into the Timeline, so let place it.

To place a clip into the Timeline:

· Choose a clip from the Project Window. 

· Use the mouse to drag it to one track on the Timeline, drop your clip in the track. 

· Drag the other clips to Video 1 track, positioning them in the right order, one against the other. See that each corresponding audio is placed in the Audio 1 track. 

This is a rough cut, giving you some idea of how your sequence works and what needs to be trimmed, edited, and modified. To see how your work is progressing, click the Play button underneath the Program view (or press the spacebar). Note that the edit line in the Timeline moves with the preview. This edit line indicates the active frame (the frame being edited or previewed).

Making a rough cut is not an obligation. You can make it directly more precise using the monitor screen.

Double-click on the clip in the Project Window, and it will open in the Source view (you can also drag it to the Source view), ready to be edited. Double-clicking on a clip on the timeline make it appears on the Source view monitor.
2.4.2 Editing the sequence

You'll need to remove the parts that you don't need: you'll need to trim your clips. Trimming a clip involves setting a new In point, Out point, or both. An In point is the frame where a clip begins; an Out point is the last frame of the clip.

Adding In and Out points in the Source view: 

· Put the clip you want to edit in the Source view Monitor, directly from the Project Window, or by double-clicking the clip in the timeline if you have already place it.

· You can set in and out points for your clips in the Monitor by clicking on these buttons: [image: image95.jpg]


. 

· The controls for both views of the Monitor window also contain a shuttle slider, which lets you scrub clips. Scrubbing (advancing or reversing a clip manually) lets you precisely identify and mark events. 
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· [image: image195.jpg]


Under the Source view, drag the shuttle slider when you want your clip to begin and click the In point button. Drag the shuttle slider when the clip must end and click the Out button.
· If you've marked a wrong point just make a new one, the new one will erase the old one. 

· Drag the clip in the timeline if it wasn't already placed. 

· If the clip was already in the timeline, depending of your version of Premiere the trim applies automatically in the timeline. Otherwise click on the 'Apply' button. 

It’s important to understand that the trimmed area has not been deleted! Premiere has hidden the trimmed frames so that they don’t appear in the Timeline and will not appear when you preview or export the video program.

You can easily restore them by resetting the In or Out points using any trimming method. 

2.4.3 Another way to Trim your clip: in the Timeline window 

One option is to trim the edges of the clip in your timeline until it is the length you want it to be. 

· Select the selection tool [image: image97.jpg]



· Identify the place you want to cut with the shuttle slider from the timeline (or from the Program monitor). 

· To get your cursor to a specific moment, use the slider-bar underneath the timeline or the one above to adjust by frame.
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· Move your mouse to the edge of the clip in the timeline. As your mouse passes over the edge, it will turn into a resize icon [image: image98.jpg][E5]




· To trim the end of the clip, just click-and-drag your clip until it is the length you want it to be. 

· You can also trim the beginning of clips: the resize icon will be [image: image99.jpg](il



. 

· You can use this option with either end or beginning of clip. If you have shortened it too much, you can extend it with the same tool. (But you will not be able to use the trim option to extend your clip past its original capture length.)

Because you've shorten your clip, there is now a gap in the Timeline between this clip and the following ones:

[image: image198.png]



To preserve a continuous flow, you need to close this gap by moving the other clips to the left. To do this, you’ll use the track selection tool [image: image100.jpg]


. This tool selects all the clips in a track to the right of where you click. Just drag the clip to the left.

2.4.4 Cut your clip

To cut your clip, you will need to use the Razor tool [image: image101.jpg]


, located in the tool section of the Timeline.

· Get your clip to the point you want to cut. To do this, play from the timeline (use the spacebar to start and stop). To get your cursor to a specific moment, use the slider-bar in the target screen to adjust by frame.

· When you have your clip where you want it, select the Razor tool and click on the cursor line. Your clip will split and a new icon will appear in the clip to the right. This tells you that the clips are now two different clips.

· Finally, choose the select tool (an arrow, top row, left corner) and select the portion of your original clip you don't want. Press "Delete" and you are done. Note: if you are using both video and sound, be sure to delete the sound portion of your clip too. 

2.5 Working with Audio

As you've noticed, when you put a video in the timeline, the corresponding audio is put in an audio track. Those 2 tracks are associated: when you trim one, the other is trimmed; if you want to remove audio, video will be removed too. 

But you can dissociate them: click on the audio or the video clip in the timeline, and select 'break link'. Now you can work with one freely from the other.

You can also add some music to the project by importing and placing audio files. Just drag them from the Project Window (or use a way we've seen previously).

In the timeline you can have an expanded view or a reduced view of your track. Click on the icon triangle next to the speaker icon:
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The expanded view shows the waveform of the clip. The horizontal line in the middle of the waveform is the volume of the clip. Drag up to increase, move down to reduce the volume. 

You can edit audio in the same way as a video clip. Double-click on it to make it appear in the Source view. 

2.6 Adding Titles

You can create very sophisticated titles, including rolling or scrolling horizontally or vertically:
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Choose File > New > Title
· Input a name

· The title dialog box appears, with a preview of your video.
· Write your title, in the preview square. Choose the parameters...

· To make a scrolling title click on the scrolling icon [image: image102.jpg]


and choose the parameters. 

· When you're finish, close the window, the title is now in the bin.

· Drag it to the video 2 track on the timeline.
2.7 Adding Effects

Underneath the Project window is the Effects tab, displaying the available effects and transitions, audio and video.
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The principle is very simple: just drag one effect to the timeline, and drop it on the clip you want the effect to be. Then you can edit the effect by double-clicking on it on the timeline. 
2.7.1 Creating Transitions

A transition is a change from one scene to the next or from one clip to another. 

Transition Effects are used to seamlessly link clips together. They are one of the key components of professional video editing. The simplest transition is the cut, where the last frame of one clip leads directly into the first frame of the next. But you can use transitions to create artistic effects such as dissolves, wipes and zooms; or a fade in/fade out to signify the passage of time... Adobe Premiere Pro comes with 73 different transitions...

To insert a transition:

· Find the two clips in the timeline where you would like a transition. Adjust the slider-bar to expand the track. 

· To create your transition, you need to overlap the two clips in the Video 1 and Video 2 tracks. The overlapping portions of the clips are used in the transition.
 [image: image104.jpg]



· Select a transition in the Effects palette and drag it to the timeline where the second clip begins (or to the juncture if both clips are on the same track). It appears in purple in the clip. 
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· Double-click on the effect in the clip to edit the transition. You can edit the transition, changing the length...: double-click on the effect in the clip, and a new panel will appear in the Monitor Window > Effect Controls. 
Depending on the effect you can change the length and other options. The letters A and B represent the 2 clips. But instead you can display images of the clips. 

2.7.2 Adding Special Effects

Adobe Premiere Pro includes a variety of audio and video effects that you can apply to clips. 

An effect can add a special visual or audio characteristic or provide an unusual feature attribute. For example, an effect can alter the exposure or colour of footage, manipulate sound, distort images, or add artistic effects. You can also use effects to rotate and animate a clip or adjust its size and position within the frame...

To add special effects:

· Drag-and-drop the effect to a clip, or select the clip and drag the effect to the Effect Control panel.

· The effects you've used are listed in the Effect Controls from the monitor view. 

· The intensity of an effect is determined by values that you control. The controls for all effects can also be animated using key frames in the Effect Controls panel or timeline panel.

· You can combine as many effects as you like on a single clip, which can produce surprising results... Just test them. 
2.7.3 Changing a clip's opacity

If a clip is on Video 2 track or higher, you can make it partially transparent by changing its opacity. The opacity option lets you superimpose one or more clips on top of others, so that two or more clips are visible at the same time.

To change the opacity of a clip:

· Select the clip you wish to alter in the timeline. The horizontal bar in the clip is the opacity bar. 

· Move the pointer onto the opacity bar and click within your clip to set a handle. The handle divides your clip into sections that you can adjust by dragging.

· Click and hold the handle and drag it downward. You see the percentage opacity as you drag.

If you reduce the opacity of a clip on Video 1, it will appear darker, because the transparency is replaced by black. But if you reduce the opacity of a clip on Video 2, the clip in video 1 will appears by transparency. This process is called superimpose. 

2.7.4 Chroma key: 

To specify that certain areas of a clip become transparent and other areas remain opaque, you need to use a transparency key. 

Let’s explain the principle:

3. How to create Chroma-Key

3.1 Introduction

Chroma key is well-known as Blue Screen principle.

A blue screen key (or a green screen key), makes a shade of blue (or green) transparent. In this way, an actor can be filmed against a blue screen, and then superimposed on an outdoor action scene. It's also commonly used for weather forecast broadcasts, wherein the presenter appears to be standing in front of a large map, but in the studio it is actually a large blue or green background. 

A chroma key is the removal of a color (or small color range) from one image. The removed color becomes transparent and reveals another image behind it. 

Chroma Key creates keys on just one color channel. 

Creating transparency with a particular color is called keying out that color. 

3.2 Why blue?

Broadcast cameras use three independent sensors, one for each color, Red, Green and Blue. 

Red, green and blue channels have all been used, but blue has been favored for several reasons. Blue is the complementary color to flesh tones (human skin tone). The most common color in most scenes is flesh tone. The opposite color is the logical choice to avoid conflicts. 

Green is used too. It has a great flexibility in matting with blue foreground objects. Green paint has greater reflectance than blue paint which can make matting easier. 

Anyway, these colors are considered to be the furthest away from skin tone.

Note that if the Chroma key subject wears clothing or accessories similar in color to the Chroma key color, they may be replaced with the background video!

The most difficult part of setting up a blue screen or green screen is even lighting and the avoidance of shadow because it is ideal to have as narrow a color range as possible being replaced. A shadow would present itself as a darker color to the camera and might not register for replacement

Sometimes the background color reflects onto the foreground subject, creating a slight blue tinge around the edges. This is known as blue spill. 

This is why preparation is crucial when it comes to a chroma key shot…
After that, the video editing software is needed to remove the keying color. 

Let’s follow our Adobe Premiere tutorial:
3.3 Adobe Premiere tutorial: Transparency key 

To specify that certain areas of a clip become transparent and other areas remain opaque, you need to use a transparency key (often referred to as a key). 

· Place the clip you want to be transparent in the Video2 track. 
[image: image106.jpg]



Here, the green zone has to be removed. 

· Add a keying effect from the Effects tab. 
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· The background is green, so you could apply the Green Screen Key filter. But sometime you'd worth chosen another filter because it won't be able to get the various shades of the green background... 
· You may use Colour Key filter. Drag the effect to the clip and adjust the parameters: 
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-Key Color: You can choose which colour to remove

-Color Tolerance: Determines how wide a range of the selected color to remove. 

-Edge Thin: Expands or contracts the mask. 

-Edge Feather: Adds a small amount of feathering to the edges of the mask to smooth things out. 
· See the preview: 

[image: image109.jpg]



4. Exporting the Project

When you're finished with your project you will need to export it. You can burn it to a DVD, record it to a video tape, or compress it. 

4.1 Export to DVD

With the version 2.0 of Premiere, you can export the timeline content to a DVD, but also create menus and sub menus!

This feature is also extremely customizable as it gives you the option of making animated backgrounds, the ability to have a background audio track and other options...

To create a menu :
· Go to Window > DVD Layout.

· To add interactive menu, choose Change Template, then you have to apply a template 
[image: image110.jpg]



· You can modify the template in the Effects control:
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· You can generate DVD markers straight from the timeline by using the DVD Marker button [image: image112.jpg]


.

· You can have a preview of your DVD : Window > DVD Layout > Preview DVD
To burn the DVD :
· File > Export > Export to DVD... 

· or Window > DVD Layout > Burn DVD
4.2 Output back to DV tape

· Make sure your camcorder is connected, turned on, and set to play with a blank tape.

· Select File > Export > Export to Tape. 

· Click record, and your video on the selected timeline will be output to tape

4.3 Export the movie

Export > Movie, Frame, Audio, or Title

These commands are used to export full-resolution files that can be archived or brought into projects for further editing. 

If you just want to export a single frame from captured video, position the playhead so that the frame you want is shown in the monitor. Then choose File > Export > Frame to save your image.
4.3.1 Compress the movie

To encode or compress the files in distribution format, use the Adobe Media Encoder. 

· File > Export > Adobe Media Encoder
· Select the best format that suits for your output goal: 
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- MPEG‑1 is used in CD-ROM authoring

- MPEG‑2 in disc authoring

-
Flash Video, QuickTime, RealMedia (Windows only), Windows Media (Windows only) are Web formats. 

· You have also the ability to preview your source video, your output video as well as the ability to crop your video, right inside the Media Encoder.

· The format you've selected determines which Preset options are available. Choose the settings, and click OK 

· Give a name to your file.

You have to know that whatever the export format you choose Premiere can take very long time to render all transitions and effects! 

	Chapter Four:

How to Produce and Manage Audio with IT

In.For.Ef (BE)


1. How to record and digitalize audio

1.1 Recording audio

Audio can be recorded directly to the computer with a microphone or a minidisk player.

Audio connections need to be made through the sound card on the back of the computer.

· If you are using a minidisk player:

· Plug the end of the cable into the blue jack on the sound card, "line input." Plug the other end into the minidisc headphone jack. Turn the volume on the minidisc player all the way up.

· Bring up the Windows volume mixer by double-clicking the speaker icon on the lower right corner of the screen. Go to Options>Properties, and select Adjust Volume For: Recording. Make sure that the "line in" box is checked, and then click "OK". This step is often a source of errors because users forget to do that!!!

· From the Mixer window, make sure that the "select" box for Line In is checked. Make sure the volume is turned up. 

· If you are using a microphone:

· Make sure your mic has a 1/8 connector. Otherwise, use the necessary adapter. Make sure the speakers are turned off, or that you are just using headphones. Otherwise, you will get feedback. 

· Bring up the Windows volume mixer by double-clicking the speaker icon on the lower right corner of the screen. Go to Options>Properties and select Adjust Volume For: Recording. Make sure that the "microphone" box is checked, and then click "OK" 

· From the Mixer window, make sure that the "select" box for Microphone is checked. Make sure the volume is turned up!

Launch your audio software, and start recording…

1.2 Digitalizing audio

Audio can also be:

· imported from S/VHS or DV in a video editing software (like Adobe Premiere) and exported as an audio file

· transferred from LP of cassette tape 

· ripped from CD 

This can be done with audio processing software, like Adobe Audition, inside which the sound can be edited.

With Audition you can: 

· Open, create and save audio files; 

· Display a waveform window of an audio file and apply zooming; 

· Play an audio file or any part of it;

· Record new audio file from a microphone or another input device; 

· Improve the quality of cassette or vinyl records (with a click and crackle filter for cleaning vinyl records, a noise filter for cassette-tape recordings…) 

· Visually edit an audio file (Cut, Copy, Delete Silence, Paste, Paste From File, Mix…); 

· Apply different effects (Amplify, Delay, Equalizer, Fade, Flanger, Invert, Normalize, Reverse, Multi Tap Delay, Silence, Stretch, Vibrato, Echo, Chorus…); 

· Apply different filters to the selected part of an audio file (Ban Pass Filter, High Pass Filter, High Shelf Filter, Low Pass Filter, Low Shelf Filter, Notch Filter). 

· Insert noise or silence in an audio file; 

· Convert an audio file from one format to another; 

· Compress an audio file;

· …
See the tutorial underneath to learn how to edit with Adobe Audition:
http://learningame.inforef.be/tutoriaux/audition.html 
2. How to create sounds of synthesis

2.1 Introduction: the Sounds Synthesis 

The sounds synthesis is a set of techniques allowing to generate and to create some sounds.

For the video games and for the virtual reality domain, the sounds synthesis allows making a virtual environment more real. In fact, the user can interact with its own environment and these interactions are attended by sounds to make them more interactive.

This creation of the sounds synthesis requires a little experiment because the possibilities offered by the software are large and some knowledge in the audio domain is required.

But, the interface of these software are more and more simple. Thus, it’s possible for an amateur to create sounds. 

2.2 Creation of sounds of synthesis with Orion 

For this example, we’ll use the synapse software called “Orion pro”.

[image: image202.jpg]


When we first open it, Orion offers an example of a sound creation to show its interface.

This interface is made up of several windows which are as many tools different used for the creation of sounds. Some of these windows are essential whereas others are more optional. You can display or mask these windows by clicking on the “windows” menu, at the top of the screen.

In this example, we’ll work with the main window, the “Song Playlist” window.

[image: image203.png]


In this window, each line represents an instrument and each column represents a sound of synthesis created beforehand.
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The whole composes your melody of synthesis made up of several sounds and instruments.

To add a line, thus a new sound, use the « insert » menu and choose which sound/instrument you want.
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The software adds automatically a new line and opens a window for this instrument. 


In the “Song Playlist” window, click on the first box of your new line, Orion will add then a new sound called A1.

Go now in the window of this instrument. At the top of this window, select the A1 reference (a). After that click on the “fingerboard” button to compose your sound. (b)
Add some notes by clicking where your want. 

To delete a note, make a right-click on it.

In order to help you in your composition, you can play your piece by clicking on the “play” button.

Once you are satisfied, return to the default display by clicking again on the “fingerboard” button.

To add another sound of the same instrument (in the same line) click on the second blank box. By default, Orion adds the sound A1. To select another sound, click on the name of this box (A1) and select another reference (Here, select the A2)

To edit the A2 sounds proceed like for the A1 sound.

You can so edit 68 sounds for each instrument. (From A1 to H8)

Once you have created your various sounds you can use the “Mixer” windows to improve your composition.

When you are satisfied with your final result, save your project and export it to a .mp3 or .midi sound by clicking on the “file” menu.

You can then use your sound of synthesis in other applications.

	Chapter Five
How to Conceive and Design an Interface
University of Patras (GR)


1. How to conceive an Interface

1.1 Introduction

A video game has many different forms; from simple flash games you play online to the newest hit for one of the big consoles. Some video games are simple while others require a great deal of practice to get the hang of.

A lot of people, however, don't really know what goes on behind the screen. You can see the moving symbols and colors, the sounds, and know that they react when you press buttons, but what actually is happening back there?

A video game is software that runs on a computer or video game console that uses a display and has a method with which a player can control the game.

While that definition is nice and simple, in order to efficiently understand video game design, you really need to know the mechanics behind it all (programming, graphic design, sound design, music composition).

1.1.1 History

The first video games were designed in the 1960s and 1970s by programmers for whom creating games was a hobby, since there was no way to sell them or earn money from creating games (the games required large mainframe computers to play). Some were designed by electrical engineers as exhibits for visitors to computer labs (OXO, Tennis for Two), others by college students who wrote games for their friends to play (Spacewar!, Star Trek, Dungeon).

Some of the games designed during this era, such as Zork, Baseball, Air Warrior and Adventure later made the transition with their game designers into the early video game industry.

Early in the history of video games, game designers were often the lead programmer or the only programmer for a game, and this remained true as the video game industry dawned in the 1970s. This person also sometimes comprised the entire art team. This is the case of such noted designers as Sid Meier, Chris Sawyer and Will Wright. A notable exception to this policy was Coleco, which from its very start separated the function of design and programming.

Today, it is rare to find a video or computer game where the principal programmer is also the principal designer, except in the case of casual games, such as Tetris or Bejeweled. With very complex games, such as MMORPGs, or a big budget action or sports title, designers may number in the dozens. In these cases, there are generally one or two principal designers and many junior designers who specify subsets or subsystems of the game. In larger companies like Electronic Arts, each aspect of the game (control, level design or vehicles) may have a separate producer, lead designer and several general designers.

1.2 The art of creating the videogame environment

Game design is primarily an artistic process, but it is also a technical process. The game designer pursues grand artistic goals even as she grinds through mountains of code. During the process of developing the game, he inhabits two very different worlds, the artistic world and the technical world. How does one manage the integration of such dissimilar worlds? In short, how does one go about the process of designing a computer game?

In the first place, game design is far too complex an activity to be reducible to a formal procedure. Furthermore, the game designer’s personality should dictate the working habits he uses. Even more important, the whole concept of formal reliance on procedures is inimical to the creative imperative of game design.

1.2.1 Choose a goal and a topic

This vitally important step seems obvious, yet is ignored time and time again by game designers who set out with no clear intent. Game designers will admit under close examination that they sought to produce a "fun" game, or an "exciting" game, but that is more often than not the extent of their thinking on goals.

A game must have a clearly defined goal. This goal must be expressed in terms of the effect that it will have on the player. It is not enough to declare that a game will be enjoyable, fun, exciting, or good; the goal must establish the fantasies that the game will support and the types of emotions it will engender in its audience. Since many games are in some way educational, the goal should in such cases establish what the player will learn. It is entirely appropriate for the game designer to ask how the game will edify its audience.

The importance of a goal does not become obvious until later in the game design cycle. The crucial problems in game development with microcomputers are always problems of trade-offs. Everything that the game designer wants to do with her game costs memory, and memory is always in short supply with microcomputers. Thus, the designer must make trade-offs. Some game features can be included, and some must be rejected. 

How do you select a proper goal? There is no objective answer to this question; the selection of a goal is the most undeniably subjective process in the art of computer game design. This is your opportunity to express yourself; choose a goal in which you believe, a goal that expresses your sense of aesthetic, your world view. Honesty is an essential in this enterprise; if you select a goal to satisfy your audience but not your own taste, you will surely produce an anemic game. It matters not what your goal is, so long as it is congruent with your own interests, beliefs, and passions. If you are true to yourself in selecting your goal, your game can be executed with an intensity that others will find compelling, whatever the nature of the game. If you are false to yourself, your game will necessarily be second-hand, me-too.

There are situations in which it is not quite possible to attain the purity of this artistic ideal. The realities of the marketplace demand that such games be written, and it is better that they be written by mature professionals than by simpering fools. Such emotionally indirect games, however, will never have the psychological impact, the artistic power, of games coming straight from the heart.

Once you have settled on your goal, you must select a topic. The topic is the means of expressing the goal, the environment in which the game will be played. It is the concrete collection of conditions and events through which the abstract goal will be communicated. For example, the goal of STAR RAIDERS apparently concerns the violent resolution of anger through skillful planning and dexterity. The topic is combat in space. The goal of EASTERN FRONT 1941 concerns the nature of modern war, and especially the difference between firepower and effectiveness. The topic is the war between Russia and Germany.

Selecting a good topic can be time-consuming, for each potential topic must be carefully examined for its ability to successfully realize the goals of the game. Many topics carry with them some excess emotional baggage that may interfere with the goals of the game.

1.2.2 Videogame Environment

You now have a clear idea of the game’s ideals but you know nothing of its form. You are now ready to begin the concrete design phase. Your primary goal in the design phase is to create the outlines of three interdependent structures: the I/O structure, the game structure, and the program structure. The I/O structure is the system that communicates information between the computer and the player. The game structure is the internal architecture of causal relationships that define the obstacles the player must overcome in the course of the game. The program structure is the organization of mainline code, subroutines, interrupts, and data that make up the entire program. All three structures must be created simultaneously, for they must work in concert. Decisions primarily relating to one structure must be checked for their impacts on the other structures.

1.2.3 Evaluation of the Videogame Environment

After you create the three structures: the I/O structure, the game structure, and the program structure, you have to evaluate them. You are satisfied that all three structures will work and that they are compatible with each other. The next stop in the design phase is to evaluate the overall design for the most common design flaws that plague games. The first and most important question is: does this design satisfy my design goals? Does it do what I want it to do? Will the player really experience what I want him to experience? If you are satisfied that the design does pass this crucial test, proceed to the next test.

Examine the stability of the game structure. Remember that a game is a dynamic process. Are there any circumstances in which the game could get out of control? For example, if the game has money in it, could a situation arise in which the player finds himself the owner of ridiculously large amounts of money? In short, does the game structure guarantee reasonable upper and lower bounds on all values? If not, re-examine the game structure carefully with an eye to structural changes that will right the situation. If you have no other options, you may be obliged to put them in by brute force (e.g., "IF MONEY > 10000 THEN MONEY 10000")

Now probe the design for unanticipated shortcuts to victory. A player who can find a way to guarantee victory with little effort on his part will not derive the full benefit of your game. Insure that all unintended shortcuts are blocked so that the player must experience those processes that you want him to experience. Any blocks you place must be unobtrusive and reasonable. The player must never notice that he is being shepherded down the primrose path. An example of obtrusive blocking comes from the game WAR IN THE EAST (trademark of Simulations Publications, Inc). This wargame deals with the Eastern Front in World War 11. The Germans blitzed deep into Russia but their advance ground to a halt before Moscow. To simulate this the designers gave the Germans an overwhelming superiority but also gave them a supply noose whose length was carefully calculated to insure that the Germans would be jerked to a dead halt just outside Moscow. The effect was correct, but the means of achieving it were too obvious, too obtrusive.

The last and most crucial decision is the decision to abort the game or proceed. It should be made now, before you commit to programming the game. Do not hesitate to abort the game now; even if you abort now you will still have I earned a great deal and can say that the effort was worthwhile. A decision to give up at a later stage will entail a real loss, so give this option careful consideration now while you can still do it without major loss. Abort if the game no longer excites you. Abort if you have doubts about its likelihood of success. Abort if you are unsure that you can successfully implement it. I have in my files nearly a hundred game ideas; of these, I have explored at length some 30 to 40. Of these, all but eight were aborted in the design stage.

2. The interface of 2D videogames

2D interfaces are flat designs. This type of design is not intended to offer exploration. 2D interfaces are useful for presenting static information.

The most common use for a 2D interface is printed material such as books, magazines, maps or advertisements, interface of 2D videogames.

2.1 Define a Look

Defining the look and feel of an interface is the fun part of the design process [
]. Artist and designers with a passion for creativity look forward to this stage of development. The early concept stage is the fun part of the process. 

When working on the look and feel of a game, have fun and take the opportunity to be creative. This is a great place to experiment and to come up with something totally unique. The look of the design is what the end users will remember. If the functionality of an interface is good, the user won’t even notice it. If you don’t enjoy designing the look of a game, you may not be cut out for interface design.

2.1.1 Create a Mock-Up

The best way to define a distinctive look for your game is to create sample art, or a mock-up of the interface. The goal of creating this sample art is not to have a final product but to define and visualize the look and feel of the entire interface. Don’t worry about having the right options listed. It is more important to show what your buttons will look like than it is to get the right button. By creating art that looks like a real interface, you make it easy for anyone who needs to review and approve your design. It does not require a lot of imagination or guesswork on the part of the producer or art director to get the idea if they can simply see it.

A mock-up can guide your design throughout the process. Once your mock-up has been created, reviewed, and approved, a standard has been set. The rest of the interface can be designed to fit in with the look and feel of the sample art. The entire interface should look and feel just like this sample art. It will be much faster to design the rest of the interface once you have set the look and feel. Much less experimentation is needed once you’ve found the style for your interface. Figure 3.1 shows an example of a mock-up.
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Figure 3.1: The mock-up of the title screen defines the colors

and style of the entire interface.
A mock-up of a single screen of the interface and just a few more pieces of art, such as some important buttons from other screens, is all you need to define a look. Figure 3.2 shows a couple of these extra elements that you might want to include in the mock-up phase. You don’t need every detail to establish your interface style. Often, the best screen to mock-up is the title screen. Legal screens, company logo screens, and even the opening cinematic sequence may appear before this title screen in the final game, but typically the title screen is the first in which options appear for the user. There are some games that have a separate title screen from the main menu, but it is usually the first screen with active buttons, and it will often contain the game logo, as well. Because it contains so many important elements, the title screen is ideal to use as a mock-up screen.

[image: image115.emf]
Figure 3.2: Creating a few more interface elements helps to 

better establish the look of the interface.

2.1.2 Working with Logos

Working with publishers and their game logos can be tricky business. The game publisher often provides the logo, and it is important to get this logo as early as you can. Too often, the publisher waits until near the end of the project to even decide on the name of the game, much less the design logo.

If the publisher is dragging its feet on coming up with a logo, create a temporary logo that captures the feel that will be used in the final logo. This may not be easy to guess, but it is better to have some reference, however flawed, than to have no reference.

Try to establish the look of the logo early, even if the name must change later. Communicate with the publisher and make sure they agree with the direction you’re taking. It is always a pain when, say, the game has a blackand - orange interface and the publisher brings you a green and purple logo at the end of the project and asks you to change the entire interface to match the cool, new logo. Even if the new logo is cool looking, if it doesn’t mach the rest of the interface, it can mean you’ll have to spend weeks reworking the art. Figure 3.3 shows how a logo can be out of place if the interface was not designed around the look of the logo.

[image: image116.emf]
Figure 3.3: The colors in this logo don’t go well with the rest

of the interface.

2.1.3 Define a Color Scheme

Color is a very important part of an interface. What color is your game? This is a good question to answer early. Anyone who looks at your interface should be able to see at a glance the color scheme of the entire game. Keeping the colors consistent throughout the game creates a unified look. Everything from the box cover to the in-game interface should reflect this color scheme and help define your game. Too many dramatic changes in color from screen to screen will make the game feel inconsistent. When creating a color chart, make sure it feels like you want your game to feel. If you are working on a game for young children, for example, then bright, saturated colors may be appropriate. The colors would probably be very different for a game based on a horror story. In such a game, the colors should look like they belong in a horror movie—a lot of black with orange or green accents may be a good choice for such a scary game. Take a look at Figure 3.4 and compare the two color charts to see how a feel can be created using only color.

[image: image117.emf]
Figure 3.4: Just by looking at these two different color schemes, 

you can tell whatkind of games they might be used for.

The subject matter of the game can often direct the color choice. If you are working on a game that takes place in a jungle, green is probably the wise color choice. If you are working on a game with demons and gargoyles, then red and black may be a logical choice. Your colors should feel like they fit with the subject matter.

Images sometimes actually get in the way of making a color choice. If you have an illustration or photo of a cool-looking red car, you may be influenced to choose red as one of the colors for your interface, even if red isn’t the best color choice. It is better to make the color choice first and then adjust the image to match your color scheme. This way, you have made the color choice independent of the colors in an image.

A good way to separate the color choice from all of the other decisions is to make a color chart. Create a file that is made up of the colors you will use in the interface. This color chart should not only contain the colors you will use in the design, but it should also have the correct proportions of each of the colors. It should roughly represent the amount of each color you will use in the actual interface. If an accent color is used in the design, it should only take up a small amount of space on the color chart. This way, the colors in your chart will feel like the final interface. Make sure to refer to this chart when working on the interface, so that you don’t lose the color balance you’ve established. Take a look at the color chart in Figure 3.5 and see how the yellow color is much smaller than the green tones. Now look at the final interface screen in Figure 3.6 and see how the color is balanced similarly to the color chart.
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Figure 3.5 This color chart establishes

the colors of an interface.

[image: image119.emf]
Figure 3.6 Compare the color chart with this final interface.

2.2 Express Yourself in the Design

Go for it! Make your design unique. This is your chance to really express your creativity. The best interface designs push the feel of the game. If you decide to design an interface with a retro, 1950s-America feel, then make sure that all of the elements fit together. Don’t just design a standard interface that has a few elements that fit the 1950s theme—make it really feel like the 1950s. Look at clothing styles, colors, cars, and kitchen appliances that were used in the 1950s. Choose some of the elements that capture the feeling you are looking for. A button on a radio or the grill of a car may inspire the shape, color, and design of your interface. If the game takes place in ancient Japan and you decide to design the interface with a classic Japanese feel, then go all the way. Look at ancient Japanese art and calligraphy. Choose a font that looks Asian or like calligraphy. Use colors, plants, cloth patterns, or anything that imparts the feel you’re striving for.

2.3 Research and Inspiration

Coming up with ideas for your design is not always easy. It’s not uncommon to hit a creative roadblock when designing an interface.When you feel like you can’t come up with any good ideas, there are a couple of techniques that you can use to help inspire yourself. Don’t let a slump hold you back for long!

2.3.1 Make Lists

A common and very effective brainstorming method is to create lists. Sit down and just start writing. Write down good ideas and even ideas that may not seem so good at the moment—just let them flow. Create several lists. List objects associated with the game. List emotions associated with the game. List actions associated with the game. Create as many categories as you can. Combine different words and phrases from different lists and see what you can come up with. You may come up with some unexpected solutions using this technique. Figure 3.7 shows an example of the beginnings of a brainstorming list.
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Figure 3.7: These are lists that were created for a children’s game about a family of

monsters that live in the jungle.

2.3.2 Search for Images

Another great creativity-inspiring technique is searching the Internet for cool, interesting, or thoughtprovoking images. You can go on a virtual field trip anywhere in world and see what things—buildings, clothing, flora, fauna, and so on— look like. If you are unfamiliar with the subject, you can quickly find visuals to help you approximate the look you’re going for in your design. When creating an interface for a Formula One racing game, for example, you could search the Internet for photographs of the cars, the crowds, the tracks, and the drivers. You may find images of elements you wouldn’t have thought of without looking at photos. Skid marks on the track, dented railing along the track, and helmets worn by the drivers may all provide inspiration and direction—and you may not have thought of them if you hadn’t searched for images online.

An amazingly large amount of information and photos can be found on the Internet. Be very careful not to violate any copyright laws, though. Use the photos and images you find for inspiration, but don’t actually use any photos if you don’t have the copyright on them. If you really need a specific photo, you may be able to purchase the rights to use it. Stock photography vendors will be happy to help you out.

You can find inspiration in other places, as well. Art galleries, libraries, and the theater can all be places where you can find inspiration. Constantly keep your eyes open. On my drive into the office, I pass several old factories with rusted metal walls, steel, and rivets. I think of how many great images and textures that can be found in these old, beat-up buildings. I often carry a digital camera so that I can stop and take a picture of anything visually arresting I come across during the day.

Another place I find a lot of inspiration is at the movies. There are so many visually stunning movies. For example, if I am working on a game that takes place in ancient Egypt, I will rent (or go see, if there is anything out) a great movie that shows architecture and art from Egypt. Animated movies are also great for inspiration. I have watched many movies with a sketchbook in my hand, ready to capture any inspiring image I see.

Check out your competition. Find out what they came up with when confronted with a similar design challenge. See what you’re competing against and learn if any unique and interesting design solutions have appeared in other games. Understand what users have come to expect of games in the genre you’re working in. Avoid any urge to copy the design of other games, though. It’s easy to make a game that looks only slightly different to a competing game. Playing a game like this won’t be very enjoyable or impressive for users. Make your design original. Don’t sell your own abilities short—even if a competitor has a great interface design, their design doesn’t represent the only great solution available.

2.3.3 Thumbnails

Thumbnails are very small sketches. They are often only an inch or two wide. They are used to quickly run through a bunch of concepts. These little sketches can be very useful when designing an interface. When I skip thumbnails and go straight to working on a full size image, most of the time I end up getting stuck and having to go back and create the thumbnails after all.

It is easy to get too excited about an interface and either skip or spend too little time on the thumbnail sketch stage. Be patient, and make a lot of thumbnails. Thumbnails are easy and fast to make, and they can allow you to try out literally hundreds of ideas quickly. If you dig right in and start creating full-size color layouts before you make thumbnails, you’ll only be able to try a limited number of approaches. Take advantage of the ease of creating thumbnails and create a lot of them.

2.3.4 Work Quickly

Keep your thumbnail designs small and simple. As the name implies, thumbnails are typically small, and they do not contain much detail; they are simply meant to help you arrange the basic layout. If they are drawn too large, you may be tempted to add too much unnecessary detail. Such unnecessary detail will slow you down and can distract you from finishing the basic layout.

Make your thumbnails quickly and keep them rough. They should be used for internal direction and should not be shown to a publisher until they have been cleaned up. Spending extra time creating tight thumbnails can be a waste. Even without the details, it is amazing how much information you can convey in a small thumbnail. The best way to make thumbnails is the old fashioned way—with a pencil and paper. It is hard to match the speed of using a pencil for thumbnail sketches. Speed is the key with thumbnail sketches. You want to try a lot of ideas quickly.

Some artists struggle to maintain a small scale and to get the screen proportions correct. The best way to solve this problem is to print out a page of small, blank boxes that are the correct size and proportions. These boxes can then be used as borders for hand-drawn thumbnails. 

2.3.5 Push for Variation

It is a good idea to push yourself to create more thumbnails than you’re initially inclined to make. You will often be more creative the further you go into the thumbnail process. At first, you may tend to create thumbnails that look similar to other interfaces you have created. Once you have run through your standard set of ideas, you will be forced to come up with more creative ideas. Don’t stop when it starts to become difficult to come up with another idea. This is often the point when new ideas appear. When you get stuck, you can create variations on each design. It is also a good idea to create many completely new layouts.

Although it’s good practice to create a lot of thumbnails, it’s often a mistake to present hundreds of ideas to the publisher for approval. The publisher may legally own all of the art created in association with the game, but they seldom require that you show them every scribble and sketch. Not only does it take longer for the publisher to sort through a large number of thumbnails, but inevitably the publisher will choose the one you like the least. Not everyone has the ability to envision a finished product from a thumbnail. Don’t run the risk that a publisher can’t see past your pencil scribbling to the magic beneath. As I said before, most thumbnails should only be used internally; if a publisher requests to see thumbnails, it is a good idea to clean up and present one or two sketches. Choose the thumbnails that you have already determined to be the best solutions.

2.4 Creativity versus Standards

Creativity is essential, but make sure that you use it in the right place. You must balance new and original ideas with standard approaches. Gamers have come to expect certain standards, and in many cases, it is better if they don’t have to think too much about a new approach. Just because you think it will be cool to, say, have the “highlighted” button grow dark instead of light up does not mean it is necessarily a good idea; it may confuse the user and take him longer to understand which button is selected. This does not mean that darkening the selected button will never work. You just need to consider what the user is expecting to see and understand that if your menu does something different, then it may make it harder for the user to navigate.

2.5 Using Photographs

Photographs can be very useful and cool-looking in your interface, but they must be used correctly or they will hurt your design. In some cases, using photos may be the very best solution or even a requirement. If you are making a game that uses the name of the latest sports star, you may need to include a photo of the athlete on the box and in the interface. A game with a movie license may also require a photo of the star. In many other instances, photos can be a crutch and can make a very bad or uninteresting interface. Photos should only be used when they are the logical solution, and not just because it’s easier to use a photo than an illustration or to create your own background. It is very obvious when an interface designer uses a bunch of stock photographs that have not been properly touched up just to save time. It just looks bad. I have a personal preference for using illustrations over photos. I usually avoid photos in an interface. Other than when you need to show a likeness of a famous person, I suggest always using an illustration. It will take more time and require more skill, but I think that a quality illustration has the potential to look much better than a photo. You will find that only a small percentage of the big, triple-A games use photos in the interface. Photos rarely fit well with the art in the game. If your budget is tight, of course, you may need to use photos instead of illustrations. You need to be aware that this may be a weak point in your interface if you don’t take the extra time to use the photos well. Making your own collage of several photos, using filters and effects, and making other adjustments to these photos can really help. Do your best to choose your photos wisely. I have seen some instances wherein an interface designer used photos and it resulted in a quality interface, but these instances are rare.

If you use photographs in your design, make sure they are of good quality. A digital camera can be incredibly useful when making games. The problem that comes along with using digital cameras, however, is that they are so easy to use that everyone thinks that he or she is a great photographer and that there is no need to spend money on a professional photographer or purchase stock photography. Many designers think, “I can take a picture of my own football and get it just the way I want it.” But in reality, the shot they end up with is not nearly as good as a professional photographer could do. Photos you have taken yourself are great for reference, but they must be high quality if you want to use them in your interface. Figure 3.8 is a photo that I took that is a little washed out. It is not a high-quality photo. 
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Figure 3.8: Digital photos that are not taken by a

professional can hurt an interface design.
Don’t be afraid to take digital photos, just understand your limits. There are many, many uses for photos. For example, they can serve as great references, as they capture details that you might not be able to remember without them. They can also provide a great start for textures. They can be used the same way the Internet can be used for research.

Photos that are to be used in your game can be touched up and edited. It’s hard to fix a bad photo, but it’s easy to improve a good photo. Whether you took the photos or they were taken by a professional photographer, there are many techniques that can be used to make the photo more interesting. Simple adjustments include changing the image levels and saturation. You can also try techniques like colorizing the photos or adding other filters. If you plan on using photos often, learn as many techniques as you can to get the most out of your photos. Figure 3.9 shows a photo that has been touched up using several different methods.
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Figure 3.9: An average photo has been adjusted in several different way to help 

enhance the photo and make it more suitable for use in an interface.

2.6 Illustrations

In place of a photograph, you might want to consider using an illustration. This approach can really improve the look of an interface. The subject matter of your game can determine which to use. For example, while a sports game may be a great place to use a photograph of all the players, an illustration may be much better solution for a fantasy game. The style of illustrations used in an interface can help define the look and feel of a game. Are the illustrations stylized or realistic, detailed or simple, colorful or desaturated? As with photographs, poor illustrations will hurt a design, but great illustrations can improve an interface significantly.

If you are confident in your skills as an illustrator, then you should do your own illustrations. If you can’t produce top-notch illustrations in the style that would best fit your interface, get an illustrator with the style you need for your game. Just because your illustration style does not fit the game does not make you a bad illustrator. Don’t force your illustration or illustration style into a design if it doesn’t work just because you want the design to be “all yours.” Figure 3.10 shows a sample of an illustration that would be hard to beat with a photograph.
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Figure 3.10 Using an illustration instead of a photo here allowed for brighter colors. 

This image would have been difficult to photograph.

3. The interface of 3D videogames

In the real world around us, we perceive objects to have measurements in three directions, or dimensions. Typically we say they have height, width, and depth.When we want to represent an object on a computer screen, we need to account for the fact that the person viewing the object is limited to perceiving only two actual dimensions: height, from the top toward the bottom of the screen, and width, across the screen from left to right.

Therefore, it's necessary to simulate the third dimension, depth "into" the screen. We call this on-screen three-dimensional (3D) simulation of a real (or imagined) object a 3D model [
]. In order to make the model more visually realistic, we add visual characteristics, such as shading, shadows, and textures. The entire process of calculating the appearance of the 3D model—converting it to an entity that can be drawn on a two-dimensional (2D) screen and then actually displaying the resulting image—is called rendering.
3.1 Introduction
3.1.1 Coordinate Systems

When we refer to the dimensional measurement of an object, we use number groups called coordinates to mark each vertex (corner) of the object. We commonly use the variable names X, Y, and Z to represent each of the three dimensions in each coordinate group, or triplet. There are different ways to organize the meaning of the coordinates, known as coordinate systems. We have to decide which of our variables will represent which dimension—height, width, or depth—and in what order we intend to reference them. Then we need to decide where the zero point is for these dimensions and what it means in relation to our object. Once we have done all that, we will have defined our coordinate system.

When we think about 3D objects, each of the directions is represented by an axis, the infinitely long line of a dimension that passes through the zero point. Width or left-right is usually the X-axis, height or up-down is usually the Y-axis, and depth or near-far is usually the Z-axis. Using these constructs, we have ourselves a nice tidy little XYZ-axis system, as shown in Figure 3.11. 
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Figure 3.11: XYZ – Axis System

Now, when we consider a single object in isolation, the 3D space it occupies is called object space. The point in object space where X, Y, and Z are all 0 is normally the geometric center of an object. The geometric center of an object is usually inside the object. If positive X values are to the right, positive Y values are up, and positive Z values are away from you, then as you can see in Figure 3.12, the coordinate system is called left-handed. The Torque Game Engine uses a slightly different coordinate system, a right-handed one. In this system, with Y and Z oriented the same as we saw in the left-handed system, X is positive in the opposite direction. In what some people call Computer Graphics Aerobics, we can use the thumb, index finger, and middle finger of our hands to easily figure out the handedness of the system we are using (see Figure 3.13). Just remember that using this technique, the thumb is always the Y-axis, the index finger is the Z-axis, and the middle finger is the X-axis. 
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	Figure 3.12: Left-handed coordinate system with vertical Y-axis.
	
	Figure 3.13: Right-handed coordinate system with vertical Y-axis.


With Torque, we also orient the system in a slightly different way: The Z-axis is updown, the X-axis is somewhat left-right, and the Y-axis is somewhat near-far (see Figure 3.14). Actually, somewhat means that we specify left and right in terms of looking down on a map from above, with north at the top of the map. Right and left (positive and negative X) are east and west, respectively, and it follows that positive Y refers to north and negative Y to south. Don't forget that positive Z would be up, and negative Z would be down. This is a right-handed system that orients the axes to align with the way we would look at the world using a map from above. By specifying that the zero point for all three axes is a specific location on the map, and by using the coordinate system with the orientation just described, we have defined our world space. 
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Figure 3.14: Right-handed coordinate system with vertical Zaxis depicting world space.

Now that we have a coordinate system, we can specify any location on an object or in a world using a coordinate triplet, such as (5,_3,_2) (see Figure 3.15). By convention, this would be interpreted as X=5, Y=_3, Z=_2. A 3D triplet is always specified in XYZ format.

Take another peek at Figure 3.15. Notice anything? That's right—the Y-axis is vertical with the positive values above the 0, and the Z-axis positive side is toward us. It is still a right-handed coordinate system. The right-handed system with Y-up orientation is often used for modeling objects in isolation, and of course we call it object space, as described earlier.We are going to be working with this orientation and coordinate system for the next little while.

[image: image128.png]



Figure 3.15 A point specified using an XYZ coordinate triplet.

3.1.2 3D Models

Let's take a closer look, by starting with a simple 3D shape, or primitive—the cube—as depicted in Figure 3.16.

The cube's dimensions are two units wide by two units deep by two units high, or 2_2_2. In this drawing, shown in object space, the geometric center is offset to a position outside the cube. I've done this in order to make it clearer what is happening in the drawing, despite my statement earlier that geometric centers are usually located inside an object. There are times when exceptions are not only possible, but necessary—as in this case. 

Examining the drawing, we can see the object's shape and its dimensions quite clearly. The lower-left-front corner of the cube is located at the position where X=0, Y=1, and Z=_2. As an exercise, take some time to locate all of the other vertices (corners) of the cube, and note their coordinates. 
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Figure 3.16: Simple cube shown in a standard XYZ axis chart

If you haven't already noticed on your own, there is more information in the drawing than actually needed. Can you see how we can plot the coordinates by using the guidelines to find the positions on the axes of the vertices? But we can also see the actual coordinates of the vertices drawn right in the chart. We don't need to do both. The axis lines with their index tick marks and values really clutter up the drawing, so it has become somewhat accepted in computer graphics to not bother with these indices. Instead we try to use the minimum amount of information necessary to completely depict the object.

We only really need to state whether the object is in object space or world space and indicate the raw coordinates of each vertex.We should also connect the vertices with lines that indicate the edges.

If you take a look at Figure 3.17 you will see how easy it is to extract the sense of the shape, compared to the drawing in Figure 3.16.We specify which space definition we are using by the small XYZ-axis notation. The color code indicates the axis name, and the axis lines are drawn only for the positive directions. Different modeling tools use different color codes, but in this book dark yellow (shown as light gray) is the X-axis, dark cyan (medium gray) is the Y-axis, and dark magenta (dark gray) is the Z-axis. It is also common practice to place the XYZ-axis key at the geometric center of the model.
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Figure 3.17: Simple cube with reduced XYZaxis key

Figure 3.18 shows our cube with the geometric center placed where it reasonably belongs when dealing with an object in object space. 
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Figure 3.18: Simple cube with axis key at geometric center

Now take a look at Figure 3.19. It is obviously somewhat more complex than our simple cube, but you are now armed with everything you need to know in order to understand it. It is a screen shot of a four-view drawing from the popular shareware modeling tool MilkShape 3D, in which a 3D model of a soccer ball was created.

In the figure, the vertices are marked with red dots (which show as black in the picture), and the edges are marked with light gray lines. The axis keys are visible, although barely so in some views because they are obscured by the edge lines. Notice the grid lines that are used to help with aligning parts of the model. The three views with the gray background and grid lines are 2D construction views, while the fourth view, in the lowerright corner, is a 3D projection of the object. The upper-left view looks down from above, with the Y-axis in the vertical direction and the X-axis in the horizontal direction. The Zaxis in that view is not visible. The upper-right view is looking at the object from the front, with the Y-axis vertical and the Z-axis horizontal; there is no X-axis. The lower-left view shows the Z-axis vertically and the X-axis horizontally with no Y-axis. In the lowerright view, the axis key is quite evident, as its lines protrude from the model.
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Figure 3.19: Screen shot of sphere model
3.1.3 3D Shapes

We've already encountered some of things that make up 3D models. Now it's time to round out that knowledge. 

As we've seen, vertices define the shape of a 3D model. We connect the vertices with lines known as edges. If we connect three or more vertices with edges to create a closed figure, we've created a polygon. The simplest polygon is a triangle. In modern 3D accelerated graphics adapters, the hardware is designed to manipulate and display millions and millions of triangles in a second. Because of this capability in the adapters, we normally construct our models out of the simple triangle polygons instead of the more complex polygons, such as rectangles or pentagons (see Figure 3.20).
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Figure 3.20: Polygons of varying complexity

By happy coincidence, triangles are more than up to the task of modeling complex 3D shapes. Any complex polygon can be decomposed into a collection of triangles, commonly called a mesh (see Figure 3.21). The area of the model is known as the surface. The polygonal surfaces are called facets—or at least that is the traditional name. These days, they are more commonly called faces. Sometimes a surface can only be viewed from one side, so when you are looking at it from its "invisible" side, it's called a hidden surface, or hidden face. A double-sided face can be viewed from either side. The edges of hidden surfaces are called hidden lines. With most models, there are faces on the back side of the model, facing away from us; called backfaces (see Figure 3.22). As mentioned, most of the time when we talk about faces in game development, we are talking about triangles, sometimes shortened to tris.
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Figure 3.21: Polygons decomposed into triangle meshes
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Figure 3.22: The parts of a 3D shape

3.2 Displaying 3D Models

After we have defined a model of a 3D object of interest, we may want to display a view of it. The models are created in object space, but to display them in the 3D world, we need to convert them to world space coordinates. This requires three conversion steps beyond the actual creation of the model in object space.

1. Convert to world space coordinates.

2. Convert to view coordinates.

3. Convert to screen coordinates.

Each of these conversions involves mathematical operations performed on the object's vertices.

The first step is accomplished by the process called transformation. Step 2 is what we call 3D rendering. Step 3 describes what is known as 2D rendering. First we will examine what the steps do for us, before getting into the gritty details.

3.2.1 Transformation

This first conversion, to world space coordinates, is necessary because we have to place our object somewhere! We call this conversion transformation. We will indicate where by applying transformations to the object: a scale operation (which controls the object's size), a rotation (which sets orientation), and a translation (which sets location).

World space transformations assume that the object starts with a transformation of (1.0,1.0,1.0) for scaling, (0,0,0) for rotation, and (0,0,0) for translation.

Every object in a 3D world can have its own 3D transformation values, often simply called transforms that will be applied when the world is being prepared for rendering.

3.2.2 Scaling

We scale objects based upon a triplet of scale factors where 1.0 indicates a scale of 1:1.

The scale operation is written similarly to the XYZ coordinates that are used to denote the transformation, except that the scale operation shows how the size of the object has changed. Values greater than 1.0 indicate that the object will be made larger, and values less than 1.0 (but greater than 0) indicate that the object will shrink.

For example, 2.0 will double a given dimension, 0.5 will halve it, and a value of 1.0 means no change. Figure 3.23 shows a scale operation performed on a cube in object space. The original scale values are (1.0, 1.0, 1.0). After scaling, the cube is 1.6 times larger in all three dimensions, and the values are (1.6, 1.6, 1.6).
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Figure 3.23 Scaling
3.2.3 Rotation

The rotation is written in the same way that XYZ coordinates are used to denote the transformation, except that the rotation shows how much the object is rotated around each of its three axes. In this book, rotations will be specified using a triplet of degrees as the unit of measure. In other contexts, radians might be the unit of measure used. There are also other methods of representing rotations that are used in more complex situations, but this is the way we'll do it in this book. Figure 3.24 depicts a cube being rotated by 30 degrees around the Y-axis in its object space.

It is important to realize that the order of the rotations applied to the object matters a great deal. The convention we will use is the roll-pitch-yaw method, adopted from the aviation community. When we rotate the object, we roll it around its longitudinal (Z) axis. Then we pitch it around the lateral (X) axis. Finally, we yaw it around the vertical (Y) axis. Rotations on the object are applied in object space.

If we apply the rotation in a different order, we can end up with a very different orientation, despite

having done the rotations using the same values.
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Figure 3.24 Rotation

3.2.4 Translation

Translation is the simplest of the transformations and the first that is applied to the object when transforming from object space to world space. Figure 3.25 shows a translation operation performed on an object. Note that the vertical axis is dark gray. As I said earlier, in this book, dark gray represents the Z-axis. Try to figure out what coordinate system we are using here. I'll tell you later in the chapter. To translate an object, we apply a vector to its position coordinates. Vectors can be specified in different ways, but the notation we will use is the same as the XYZ triplet, called a vector triplet. For Figure 3.25, the vector triplet is (3,9,7). This indicates that the object will be moved three units in the positive X direction, nine units in the positive Y direction, and seven units in the positive Z direction. Remember that this translation is applied in world space, so the X direction in this case would be eastward, and the Z direction would be down (toward the ground, so to speak). Neither the orientation nor the size of the object is changed.
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Figure 3.25 Translation

3.2.5 Full Transformation

So now we roll all the operations together. We want to orient the cube a certain way, with a certain size, at a certain location. The transformations applied are scale (s)=1.6,1.6,1.6, followed by rotation (r)=0,30,0, and then finally translation (t)=3,9,7. Figure 3.26 shows the process.
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Figure 3.26: Fully transforming the cube

The order that we use to apply the transformations is important. In the great majority of cases, the correct order is scaling, rotation, and then translation. The reason is that different things happen depending on the order. You will recall that objects are created in object space, then moved into world space. The object's origin is placed at the world origin. When we rotate the object, we rotate it around the appropriate axes with the origin at (0,0,0), then translate it to its new position. If you translate the object first, then rotate it (which is still going to take place around (0,0,0), the object will end up in an entirely different position as you can see in Figure 3.27.
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Figure 3.27: Faces on an irregularly shaped object

3.2.6 Rendering

Rendering is the process of converting the 3D mathematical model of an object into an on-screen 2D image. When we render an object, our primary task is to calculate the appearance of the different faces of the object, convert those faces into a 2D form, and send the result to the video card, which will then take all the steps needed to display the object on your monitor.

We will take a look at several different techniques for rendering, those that are often used in video game engines or 3D video cards. There are other techniques, such as ray-casting, that aren't in wide use in computer games—with the odd exception, of course—that we won't be covering here.

In the previous sections our simple cube model had colored faces. In case you haven't noticed (but I'm sure you did notice), we haven't covered the issue of the faces, except briefly in passing.

A face is essentially a set of one or more contiguous co-planar adjacent triangles; that is, when taken as a whole, the triangles form a single flat surface. If you refer back to Figure 3.22, you will see that each face of the cube is made with two triangles. Of course, the faces are transparent in order to present the other parts of the cube.

3.2.7 Flat Shading

Figure 3.28 provides an example of various face configurations on an irregularly shaped object. Each face is presented with a different color (which is visible as different shades). All triangles with the label A are part of the same face; the same applies to the D triangles. The triangles labeled B and C are each single-triangle faces.
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Figure 3.18 Faces on an irregularly shaped object

When we want to display 3D objects, we usually use some technique to apply color to the faces. The simplest method is flat shading, as used in Figure 3.27. A color or shade is applied to a face, and a different color or shade is applied to adjacent faces so that the user can tell them apart. In this case, the shades were selected with the sole criterion being the need to distinguish one face from the other.

One particular variation of flat shading is called Z-flat shading. The basic idea is that the farther a face is from the viewer, the darker or lighters the face.

3.2.8 Lambert Shading

Usually color and shading are applied in a manner that implies some sense of depth and lighted space. One face or collection of faces will be lighter in shade, implying that the direction they face has a light source. On the opposite side of the object, faces are shaded to imply that no light, or at least less light, reaches those faces. In between the light and dark faces, the faces are shaded with intermediate values. The result is a shaded object where the face shading provides information that imparts a sense of the object in a 3D world, enhancing the illusion. This is a form of flat shading known as lambert shading (see Figure 3.29).
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Figure 3.29 Lambert-shaded object.
3.2.9 Gouraud Shading

A more useful way to color or shade an object is called gouraud shading. Take a look at Figure 3.30. The sphere on the left (A) is flat shaded, while the sphere on the right (B) is gouraud shaded. Gouraud shading smoothes the colors by averaging the normals (the vectors that indicate which way surfaces are facing) of the vertices of a surface. The normals are used to modify the color value of all the pixels in a face. Each pixel's color value is then modified to account for the pixel's position within the face. Gouraud shading creates a much more natural appearance for the object, doesn't it? Gouraud shading is commonly used in both software and hardware rendering systems.
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Figure 3.30: Flat-shaded (A) and gouraudshaded (B) spheres

3.2.10 Phong Shading

Phong shading is a much more sophisticated—and computation-intensive—technique for rendering a 3D object. Like gouraud shading, it calculates color or shade values for each pixel. Unlike gouraud shading (which uses only the vertices' normals to calculate average pixel values), phong shading computes additional normals for each pixel between vertices and then calculates the new color values. Phong shading does a remarkably better job (see Figure 3.31), but at a substantial cost.

Phong shading requires a great deal of processing for even a simple scene, which is why you don't see phong shading used much in real-time 3D games where frame rate performance is important. However, there are games made where frame rate is not as big an issue, in which case you will often find phong shading used.
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Figure 3.31: Phong-shaded sphere

3.2.11 Fake Phong Shading

There is a rendering technique that looks almost as good as phong shading but can allow fast frame

rates. It's called fake phong shading, or sometimes fast phong shading, or sometimes even phong approximation rendering.Whatever name it goes by, it is not phong rendering. It is useful, however, and does indeed give good performance.

Fake phong shading basically employs a bitmap, which is variously known as a phong map, a highlight map, a shade map, or a light map. I'm sure there are other names for it as well. In any event, the bitmap is nothing more than a generic template of how the faces should be illuminated (as shown in Figure 3.32).

As you can tell by the nomenclature, there is no real consensus about fake phong shading. There are also several different algorithms used by different people. This diversity is no doubt the result of several people independently arriving at the same general concept at roughly the same time—all in search of better performance with high-quality shading.

[image: image145.png]



Figure 3.32 Example of a fake phong highlight map

3.2.12 Texture Mapping

Texture mapping is covered in more detail in Chapters 8 and 9. For the sake of completeness, I'll just say here that texture mapping an object is something like wallpapering a room. A 2D bitmap is "draped" over the object, to impart detail and texture upon the object, as shown in Figure 3.33.

Texture mapping is usually combined with one of the shading techniques covered in this chapter.
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Figure 3.23 Texture-mapped and gouraud-shaded cube

3.2.13 Shaders

When the word is used alone, shaders refer to shader programs that are sent to the video hardware by the software graphics engine. These programs tell the video card in great detail and procedure how to manipulate vertices or pixels, depending on the kind of shader used.

Traditionally, programmers have had limited control over what happens to vertices and pixels in hardware, but the introduction of shaders allowed them to take complete control.

Vertex shaders, being easier to implement, were first out of the starting blocks. The shader program on the video card manipulates vertex data values on a 3D plane via mathematical operations on an object's vertices. The operations affect color, texture coordinates, elevation-based fog density, point size, and spatial orientation.

Pixel shaders are the conceptual siblings of vertex shaders, but they operate on each discrete viewable pixel. Pixel shaders are small programs that tell the video card how to manipulate pixel values. They rely on data from vertex shaders (either the engine-specific custom shader or the default video card shader function) to provide at least triangle, light, and view normals.

Shaders are used in addition to other rendering operations, such as texture mapping.

3.2.14 Bump Mapping

Bump mapping is similar to texture mapping.Where texture maps add detail to a shape; bump maps enhance the shape detail. Each pixel of the bump map contains information that describes aspects of the physical shape of the object at the corresponding point, and we use a more expansive word to describe this—the texel. The name texel derives from texture pixel.

Bump mapping gives the illusion of the presence of bumps, holes, carving, scales, and other small surface irregularities. If you think of a brick wall, a texture map will provide the shape, color, and approximate roughness of the bricks. The bump map will supply a detailed sense of the roughness of the brick, the mortar, and other details. Thus bump mapping enhances the close-in sense of the object, while texture mapping enhances the sense of the object from farther away.

Bump mapping is used in conjunction with most of the other rendering techniques.

3.2.15 Environment Mapping

Environment mapping is similar to texture mapping, except that it is used to represent effects where environmental features are reflected in the surfaces of an object. Things like chrome bumpers on cars, windows, and other shiny object surfaces are prime candidates for environment mapping.

3.2.16 Mipmapping

Mipmapping is a way of reducing the amount of computation needed to accurately texture-map an image onto a polygon. It's a rendering technique that tweaks the visual appearance of an object. It does this by using several different textures for the texture-mapping operations on an object. At least two, but usually four, textures of progressively lower resolution are assigned to any given surface, as shown in Figure 3.34. The video card or graphics engine extracts pixels from each texture, depending on the distance and orientation of the surface compared to the view screen.
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Figure 3.34: Mipmap textures for a stone surface.

In the case of a flat surface that recedes away from the viewer into the distance, for pixels on the nearer parts of the surface, pixels from the high-resolution texture are used (see Figure 3.35). For the pixels in the middle distances, pixels from the medium-resolution textures are used. Finally, for the faraway parts of the surface, pixels from the low-resolution texture are used.
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Figure 3.35: Receding mipmap textures on a stone surface

3.2.17 Scene Graphs

In addition to knowing how to construct and render 3D objects, 3D engines need to know how the objects are laid out in the virtual world and how to keep track of changes in status of the models, their orientation, and other dynamic information. This is done using a mechanism called a scene graph, a specialized form of a directed graph. The scene graph maintains information about all entities in the virtual world in structures called nodes.

The 3D engine traverses this graph, examining each node one at a time to determine how to render each entity in the world. Figure 3.36 shows a simple seaside scene with its scene graph. The nodes marked by ovals are group nodes, which contain information about themselves and point to other nodes. The nodes that use rectangles are leaf nodes. These nodes contain only information about themselves.

Note that in the seaside scene graph, not all of the nodes contain all of the information that the other nodes have about themselves.

Many of the entities in a scene don't even need to be rendered. In a scene graph, a node can be anything. The most common entity types are 3D shapes, sounds, lights (or lighting information), fog and other environmental effects, viewpoints, and event triggers.

When it comes time to render the scene, the Torque Engine will "walk" through the nodes in the tree of the scene graph, applying whatever functions to the node that are specified. It then uses the node pointers to move on to the next node to be rendered.
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Figure 3.36: Simple scene graph
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� This tutorial was done by Emanuele Pavarotti, and more examples can be found at http://multimediart.pixel-online.net/


� This section is by Jacopo Rovida, and an interactive version of the tutorial can be found at http://multimediart.pixel-online.net/


� This example has been realized by Massimo Lojacono, and you can find more information on http://multimediart.pixel-online.net/


� Game Interface Design, by Brent Fox.


� 3D Game Programming All in One, by Kenneth C. Finney.
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